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Preface

Oracle Fail Safe supports a wide variety of high-availability business solutions on 
commodity Windows NT cluster hardware. Oracle Fail Safe release 3.0.3 support 
includes not only Oracle databases, but also Web servers, Oracle Forms and Reports 
Servers, and all applications that can be configured as a Windows NT service 
(including Oracle Applications components and Oracle WebDB).

This guide provides step-by-step procedures to help you quickly implement high 
availability solutions with Oracle Fail Safe. It includes installation, deinstallation, 
and upgrade instructions.

Intended Audience
This guide is intended for anyone who needs to perform the initial setup and 
installation of Oracle Fail Safe and Microsoft Cluster Server (MSCS) on Windows 
NT systems.

In general, this book defines technical terms and concepts when they are 
introduced. However, it assumes that you know the underlying operating system 
and are familiar with basic system administration tasks.

Also, you should be familiar with Microsoft Cluster Server (MSCS), Oracle 
Enterprise Manager, Net8 and/or SQL*Net networking, Oracle Developer products, 
Oracle Application Server, and management of single-instance Oracle databases on 
Windows NT systems.
xi



Structure
This guide contains five chapters, five appendixes, and an index:

Related Documents
In addition to this installation guide, the Oracle Fail Safe documentation set 
includes the following:

■ Oracle Fail Safe Release Notes

■ Oracle Fail Safe Concepts and Administration Guide

■ For online assistance, Oracle Fail Safe Manager provides online help topics, a 
quick tour, and a tutorial. To access the online help topics, click Help on the 
menu bar of the main Oracle Fail Safe Manager window.

Refer to the following documentation for information about related products:

Chapter 1 Explains the process of setting up and installing Oracle Fail Safe. 

Chapter 2 Provides a step-by-step walkthrough of installing Oracle Fail 
Safe software.

Chapter 3 Describes how to start Oracle Fail Safe Manager and connect to a 
cluster.

Chapter 4 Describes how to deinstall Oracle Fail Safe software.

Chapter 5 Helps you to diagnose and troubleshoot problems that might 
occur during installations and deinstallations.

Appendix A Describes how to perform a rolling upgrade to install Oracle Fail 
Safe and other Oracle software while maintaining a highly 
available environment.

Appendix B Describes how to automate the Oracle Fail Safe installation by 
performing a silent installation.

Appendix C Describes how to manually register and unregister the Oracle 
resource DLL files with the MSCS software.

Appendix D Guides you through preliminary cluster setup.

Appendix E Provides a step-by-step walkthrough of installing Microsoft 
Cluster Server (MSCS) software.
xii



■ For more information about cluster systems, see the Microsoft Cluster Server 
(MSCS) documentation.

■ For more information about the Oracle server and how it works, refer to the 
Oracle Server Concepts manual.

■ For more information about the Oracle Call Interface (OCI), refer to the Oracle 
Call Interface Programmer’s Guide.

■ For more information about Net8, refer to the Oracle8 Networking Net8 
Administrator’s Guide.

■ For more information about Oracle Enterprise Manager, refer to the Oracle 
Enterprise Manager product documentation.

■ For more information about Oracle Application Server, refer to the Oracle 
Application Server Overview and Glossary.

■ For more information about Oracle Developer Forms and Reports, refer to the 
Oracle Developer documentation set.

Conventions
This guide uses the conventions shown in the following table:

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted.

boldface text Boldface type in text indicates a screen prompt, menu selection, 
button, or value to be filled in.

italics Italics are used to indicate technical terms when they are first 
mentioned.

Menu -> Option
-> Submenu Option

The right arrow indicates an abbreviated instruction for choosing 
a menu option or submenu option. The following example means 
pull down the View menu, move the pointer to pull down the 
Image submenu, and choose the Refresh option:

Choose View -> Image -> Refresh
xiii



Additional Help
Contact your Oracle support representative for technical assistance and additional 
information, or visit the following Web site to find out about other available 
resources:

http://www.oracle.com/support/

Documentation Sales
Online product documentation is shipped with each Oracle software order. This 
documentation can be found on the Oracle Fail Safe software media. 

All U.S. customers may purchase this documentation in printed form from the 
Oracle Store by calling 1-800-Oracle1. Outside the U.S., please contact your local 
sales office. Use the following part numbers when placing an order:

■ Oracle Fail Safe Installation Guide, Part No. A75678-01

■ Oracle Fail Safe Concepts and Administration Guide, Part No. A75679-01

monospace text File names and directories appear in a monospaced font. Also, 
monospaced characters in text preceding a code example indicate 
a file name or keyword used in the sample code.

Convention Meaning
xiv
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Introduction and Preinstallation Checklist

This guide uses a step-by-step approach to assist you with the installation of Oracle 
Fail Safe release 3.0.3. Typically, you will perform your installation using the Oracle 
Universal Installer graphical user interface (GUI). If you need to perform the same 
installation on multiple machines, you may want to run Oracle Universal Installer 
in silent mode to automate the installation process in batch files or scripts. Silent 
installations are described in Appendix B.

The following topics are discussed in this chapter:

1.1 Product Compatibility
Table 1–1 shows all of the supported software and release information for products 
that are compatible with Oracle Fail Safe. 

Even though this installation guide is specific to Oracle Fail Safe release 3.0.3, the 
table also includes information about all of the previous Oracle Fail Safe releases. 
This information is included for users who are upgrading from an earlier release of 
Oracle Fail Safe and might find this additional software compatibility information 
helpful before beginning the installation.

Topic Reference

Product Compatibility Section 1.1

Conventions Section 1.2

Cluster Setup Prerequisites Section 1.3

Recommended Order for Software Installation Section 1.4
cklist 1-1



Product Compatibility
Oracle Fail Safe release 3.0.3 also supports all applications installed as Microsoft 
Windows NT services, including Oracle Applications Release 11 and Oracle WebDB.

Table 1–1 Oracle Fail Safe Software Compatibility Chart

Oracle Fail Safe Release 2.1.2 Release 2.1.3/2.1.3.1.0 Release 3.0.3

Microsoft Windows NT
Enterprise Edition 4.01

1 Supported for server systems running Oracle Fail Safe Server or Oracle Fail Safe Manager, or for client 
systems running Oracle Fail Safe Manager.

Service Pack 3 Service Pack 3
Service Pack 42

Service Pack 5

2 Supported only by release 2.1.3.1.0.

Service Pack 3
Service Pack 4
Service Pack 5

Microsoft Windows 
95/983

3 Supported for client systems running Oracle Fail Safe Manager.

Windows 95
(Service Pack 1)

Windows 95
(Service Pack 1)
Windows 98

Windows 95
(Service Pack 2)
Windows 98

Microsoft Cluster 
Server (MSCS)

Version 1.0
 (Build 224) 

Version 1.0
 (Build 224) 

Version 1.0
 (Build 224) 

JInitiator Not supported Not supported Version 1.1.7.15.1

Oracle Application 
Server

Not supported Not supported Release 4.0.74

Release 4.0.8

4 Requires Microsoft Window NT Enterprise Edition 4.0, Service Pack 3.

Oracle Database Oracle 7.3.3.2
Oracle 7.3.4
Oracle 8.0.4

Oracle 7.3.3.2
Oracle 7.3.4
Oracle 8.0.4
Oracle 8.0.5

Oracle 7.3.4
Oracle 8.0.4
Oracle 8.0.5
Oracle 8.0.6
Oracle 8.1.5

Oracle Developer Not supported Not supported Oracle Forms 6.0.5.0.2
Oracle Reports 6.0.5.28.0

Oracle Enterprise 
Manager

Release 1.5.0 Release 1.6.0 Release 1.6.05

Release 2.06

5 Requires the nmiconf.tcl patch to open the database folder in an Oracle Fail Safe environment.
6 Requires the Oracle8 8.0.5.1 patch to work with Oracle Intelligent Agent 8.0.5 in an Oracle Fail Safe 

environment.

Microsoft Internet 
Information Server (IIS)

Not supported Not supported Release 4.02.0622
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Cluster Setup Prerequisites
1.2 Conventions
Screen captures that were taken during an Oracle Fail Safe installation, 
configuration, and deployment effort form the basis for this guide. The screens and 
dialog boxes represent valid choices made during an actual installation of Oracle 
Fail Safe, Microsoft Cluster Server, and other related components.

Note that some screens do not include explicit complementary text informing the 
user what to do. In these cases, the context in which the screen appears should 
provide sufficient explanation.

1.3 Cluster Setup Prerequisites
You should perform the following configuration tasks prior to the installation of 
Oracle Fail Safe:

Ensure that you have a two-node cluster hardware configuration listed on the 
Microsoft hardware compatibility list for Windows NT clusters. The Microsoft 
hardware compatibility list is available at this URL:      
http://www.microsoft.com/isapi/hwtest/hcl.idc 

❏ Install Windows NT Server Enterprise Edition 4.0, Service Pack 3, 4, or 5 on 
each system that will be a cluster node.

❏ Install optional Oracle products that you plan to configure in a cluster group 
with Oracle Fail Safe. For example, the database server must be installed on 
each cluster node if you plan to add an Oracle database server to a cluster 
group.

❏ Ensure that each system supports TCP/IP.

❏ Check that each system has the proper Net8 (or SQL*Net) TNSNAMES.ORA 
configuration to allow the system to connect to its local database (if applicable) 
as well as to the databases on the other systems.

Note: Keep the shared storage devices powered off during all of 
the preliminary setup procedures. Until you install Microsoft 
Cluster Server, there is no reliable way to coordinate access to the 
shared storage devices.
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Cluster Setup Prerequisites
❏ Configure a client computer as a Primary Domain Controller (PDC).

❏ Create a domain account with Domain Administrators rights on the PDC for 
use with MSCS.

❏ Configure the PDC to act as a DNS server (see Section D.1).

❏ Allocate a minimum of four IP addresses for use in an Oracle Fail Safe 
environment. The addresses are used as follows:

– Two IP addresses for the cluster nodes; that is, one IP address for each 
server node in the cluster

– One IP address for the cluster alias

– One IP address so that you can create one group

One IP address is the minimum. However, you should plan to allocate 
additional IP addresses to accommodate each group that you plan to create. 
Each group requires one IP address for the virtual address.

❏ Install all required cluster-aware drivers for the SCSI or Fibre Channel, or other 
disk and data connections according to your hardware vendor’s 
recommendations.

❏ Install all drivers for the Network Interconnect Cards (NICs) on the cluster 
nodes and ensure that the devices are working properly.

❏ Ensure that:

■ Each computer (the cluster nodes and the client or PDC) is connected to the 
same LAN

■ Each cluster node is a member of the Windows NT domain sponsored by 
the PDC 

Note: After installing the Oracle database server, stop all Oracle 
services, start Oracle Installer or Oracle Universal Installer (as 
appropriate), and remove the Oracle Trace Collection Services 
because they might cause memory access violations.

Note: The Microsoft Cluster Server documentation recommends 
that you do not configure the cluster nodes as primary or backup 
domain controllers.
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Recommended Order for Software Installation
■ The PDC is listed as the primary DNS server

❏ Add each cluster node to the Primary Domain Controllers (PDCs) domain.

❏ Format each physical disk of the shared storage (or logical volume when using 
RAID) into a single NTFS partition (see Section D.5).

❏ Synchronize the drive letters for the shared storage between the two cluster 
nodes (see Section D.6).

1.4 Recommended Order for Software Installation
Although this guide describes the MSCS and Oracle Fail Safe installations in detail, 
a number of other products also must be installed to implement your Oracle Fail 
Safe environment. The following figure shows the recommended order for 
installing software.

The following list provides more detail about the installation order and other tasks 
to help you get started with Oracle Fail Safe:

1. On one cluster node (Node 1), install:

a. Microsoft Windows NT Enterprise Edition 4.0 on a private (system) disk.

b. Microsoft Cluster Server (MSCS) on a private disk (see Appendix E).

c. Optional Oracle software (database server, Forms and Reports Servers, Web 
servers, and other applications) that you plan to use with Oracle Fail Safe. 

Node 1 Node 2

Step 1: 
Install or upgrade:
   WNT Enterprise Edition
   MSCS
   Optional Oracle software
   

Step 3: 
Install or upgrade:
  Oracle Fail Safe Server
  Oracle Fail Safe Manager

Step 2: 
Install or upgrade:
   WNT Enterprise Edition
   MSCS
   Optional Oracle software
   

Step 4: 
Install or upgrade:
  Oracle Fail Safe Server
  Oracle Fail Safe Manager
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Recommended Order for Software Installation
* Install executable application files in an Oracle home or homes located 
on private disks (for example, on the system disk for each node). 

* Install application data and log files on the shared cluster disks.

* Install alert and trace files on either the shared cluster disks or on the 
private disk.

Installing alert and trace files on private disks allows the administrator 
to determine on which node problems occur, but requires that you 
maintain two separate sets of files. Placing parameter files on private 
disks is recommended only when you want the parameters to be differ-
ent on each cluster node. For example, this can be useful if you want a 
database to use fewer resources on its failover node than on its primary 
node (such as when you know there is another application or database 
server on the failover node that needs some resources).

For information about re-creating Oracle databases on cluster disks, refer to the 
Import/Export documentation that is specific to your database.

The following figure indicates the software and files that you install on private 
disks and shared cluster disks.

2. Repeat step 1 on Node 2.

Node 1 Node 2

Cluster Disks

Application Data
and Log Files

Private Disk Private Disk

Executable 
Application Files:
- Oracle Fail Safe
- Windows NT Enterprise Edition
- MSCS
- Oracle Application Server Web Listener
- Microsoft Internet Information Server
- ORANT\BIN (Oracle Homes)
- Third-Party Applications
- . . . 

Executable 
Application Files:
- Oracle Fail Safe
- Windows NT Enterprise Edition
- MSCS
- Oracle Application Server 
   Web Listener
- Microsoft Internet Information 
  Server (IIS)
- ORANT\BIN (Oracle Homes)
- Third-Party Applications
- . . . - Database Data Files

- Database Control Files
- Database Log Files
- Forms (.fmx) Files 
- Reports (.rdf) Files
- Web Pages (.html)
- . . . 
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Recommended Order for Software Installation
3. On Node 1, install Oracle Fail Safe Server release 3.0.3, including any additional 
(optional) product components for the products that you installed in step 1c. 
You can install Oracle Fail Safe Manager at the same time. 

See Chapter 2 for complete information about installing Oracle Fail Safe.

4. Repeat step 3 on Node 2.

5. On each cluster node, test the TCP/IP connections using the Windows ping 
command.

To validate that the IP addresses and host names resolve properly across the 
cluster, perform the following tests to ensure that pinging returns the same 
address on each node:

■ Ping Node 1 on Node 1 and Node 2.

■ Ping Node 2 on Node 1 and Node 2 .

■ Ping the cluster alias from each cluster node.

See the troubleshooting chapter in the Oracle Fail Safe Concepts and 
Administration Guide for more information about network configuration 
problems.

6. If desired, install Oracle Fail Safe Manager on one or more client machines (for 
example, to set up additional management consoles).

7. Start Oracle Fail Safe Manager, connect to the cluster alias with a domain 
account that has Administrator permission on each cluster nodes, and run the 
Verify Cluster operation when prompted.

See Chapter 3 for information to help you get started with Oracle Fail Safe.

8. Refer to the Oracle Fail Safe tutorial for step-by-step information about creating 
a group and adding resources to it. (To invoke the tutorial from the Oracle Fail 
Safe Manager, choose Help -> Tutorial.)
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Recommended Order for Software Installation
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Installing Oracle Fai
2

Installing Oracle Fail Safe

This chapter provides a step-by-step walkthrough of installing Oracle Fail Safe 
Manager and Oracle Fail Safe Server (including optional components such as a 
database, Forms, Reports, and some Web components). 

The discussions in this chapter assume that you have already set up your hardware 
configuration and installed Microsoft Windows NT Enterprise Edition 4.0, Service 
Pack 3, 4, or 5 and Microsoft Cluster Server Version 1.0 (Build 224) as described in 
Appendix D and Appendix E. If you plan to configure Oracle products or other 
components with Oracle Fail Safe, install the component software prior to installing 
Oracle Fail Safe.

The following topics are discussed in this chapter:

2.1 Before You Install Checklist
Check these conditions before beginning the installation procedure:

Note: If you are upgrading to Oracle Fail Safe release 3.0.3 from 
release 2.1.3 or earlier, see Appendix A for information about 
performing a rolling upgrade.

Procedure Reference

Before You Install Checklist Section 2.1

Start Oracle Universal Installer Section 2.2

Install the Oracle Fail Safe Software Section 2.3

After Installation: Verify the OracleFailSafe Service Section 2.4
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Start Oracle Universal Installer
❏ Verify release of any other Oracle software or third-party software that you plan 
to use with Oracle Fail Safe against the software compatibility guidelines that 
are documented in Table 1–1.

❏ Ensure that all of the cluster nodes are up and running.

❏ If necessary, install MSCS and verify that the cluster is up and running on all 
nodes. (See Appendix E for detailed information.)

❏ Install additional components that you want to configure with Oracle Fail Safe 
(Oracle database server, Oracle Developer, Web applications, and so on). 

❏ Plan your installation strategy for multiple Oracle homes. If you are installing 
on a system with multiple Oracle homes, refer to documentation for the Oracle 
component to find compatibility information.

❏ Log on to both cluster nodes using the same domain user account that has 
Administrator permissions. The account from which you run Oracle Universal 
Installer must have Administrator permissions.

2.2 Start Oracle Universal Installer
Oracle Universal Installer, which is included in the Oracle Fail Safe software kit, 
must be used to install Oracle Fail Safe release 3.0.3.

Step 1.  Start Oracle Universal Installer.
Use either of the following methods:

■ Load the Oracle Fail Safe CD-ROM in the drive. Oracle Universal Installer is 
invoked automatically.

■ Run the Oracle Fail Safe setup.exe program, as follows:

– On the Windows Start Menu, choose Start -> Run. 

– In the Run dialog box, enter the full path of the setup.exe program, which is 
located on the Oracle Fail Safe installation CD-ROM at:

<CD-ROM_drive_letter>:\install\setup.exe
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Install the Oracle Fail Safe Software
In the following example, F: is the drive where you loaded the CD-ROM:

Step 2.  Click the OK button to proceed.

2.3 Install the Oracle Fail Safe Software
Install the Oracle Fail Safe Server on all cluster nodes but perform the installation 
sequentially on only one node at a time. Optionally, you can install Oracle Fail Safe 
Manager on the cluster nodes at the same time.

To install Oracle Fail Safe software on the cluster nodes, they must be running the 
following software:

■ Microsoft Windows NT Version 4.0 Enterprise Edition

■ MSCS

To install Oracle Fail Safe Manager on client systems, they can be running either 
Microsoft Windows NT, Window 95, or Windows 98.

Check the software compatibility information in Table 1–1 to verify which software 
releases are supported. 

Step 1.  Verify installed components and Oracle homes.
After you start Oracle Universal Installer (described in Section 2.2), the Welcome 
window shown in Figure 2–1 is displayed. 
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Install the Oracle Fail Safe Software
Figure 2–1 Oracle Universal Installer Welcome Window

You can optionally click Installed Products to view the Oracle components that are 
already installed and the Oracle homes where they reside.

Click Next to proceed.

Step 2.  Specify the Oracle home directory for the Oracle Fail Safe installation.
In the File Locations dialog box (shown in Figure 2–2), the destination directory is 
the location where you want to install the Oracle Fail Safe software. Install Oracle 
Fail Safe on a private disk on each cluster node.
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Figure 2–2 Specifying the Oracle Home Directory 

Source:  Accept the default source directory location that is supplied 
automatically by the installer. Typically, you do not need to change the directory 
location that is supplied.

Destination:  Specify a unique Oracle home name where you want to install the 
Oracle Fail Safe software. Note the following conditions:

■ Install Oracle Fail Safe on a private disk, not on a cluster shared disk.

■ Install the Oracle Fail Safe release 3.0.3 software in a new Oracle home. Oracle 
Fail Safe should be the only product installed in the Oracle home.

You cannot specify an Oracle home that contains components installed with 
Oracle Installer (the predecessor to Oracle Universal Installer); you must specify 
only those Oracle homes that were created by Oracle Universal Installer. To 
more easily upgrade to future releases of Oracle Fail Safe, it is recommended 
that you install Oracle Fail Safe in its own Oracle home.
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■ Install the Oracle Fail Safe software in only one Oracle home; not in multiple 
Oracle homes. (Oracle Universal Installer prevents you from installing Oracle 
Fail Safe in more than one Oracle home.) The name of the Oracle home and its 
directory location must be the same on both nodes in the cluster. 

■ Install the Oracle Fail Safe Manager software in the same Oracle home with 
Oracle Fail Safe Server. Although it is possible to have the components in 
different Oracle homes, it is best to install both in the same Oracle home.

Click Next to load the installation information from the source location. The 
installer displays a Loading Product Information window that is incremented as the 
Oracle Fail Safe components are loaded.

Step 3.  Select an installation type.
You can select the Typical, Complete, Client Only, or Custom or Reinstall 
installation option from the Installation Types window shown in Figure 2–3. 
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Figure 2–3 Choosing an Installation Type 

Typical is the default installation type.

If you choose the Typical, Complete, or Client Only option, Oracle Universal 
Installer automatically installs the preselected components that are shown in the fol-
lowing figure: 
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If you choose the Custom or Reinstall option, Oracle Universal Installer displays 
the window shown in Figure 2–4. By default, Oracle Fail Safe Manager, Oracle Fail 
Safe Server, and all of the components and subcomponents are preselected. You 
must deselect the components that you do not want to install.

For example, if you plan to use only an Oracle database server and Oracle Reports 
Server with Oracle Fail Safe, you must deselect all of the other components by 
clicking their check boxes.

With the Custom or Reinstall option, you can install one or more of the following 
optional components:

■ Generic Service

■ Microsoft IIS Server

■ Oracle Application Server

■ Oracle Forms

■ Oracle Intelligent Agent

■ Oracle Reports

■ Oracle Database

■ Oracle Sample Databases

Oracle Fail Safe Documentation
Oracle Fail Safe Quick Tour
Java Runtime Environment
Oracle Universal Installer
Oracle Fail Safe Manager
Oracle Fail Safe Server
Oracle Sample Databases
Generic Service Component
Oracle Intelligent Agent Component
Oracle Forms Component
Oracle Reports Component
Oracle Application Server Component
Microsoft IIS Component

Client
Only

Typical

Complete
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Figure 2–4 Custom Installation Options 

Installing and using sample database files: Optionally, you can install the sample 
database files when you install Oracle Fail Safe, or save disk space by leaving the 
sample database file on the CD-ROM.

■ If you select Sample Databases, the installer checks to see which database 
releases are installed on the cluster node and installs only the sample database 
files with the same release number. It installs the sample database files in the 
same Oracle home as Oracle Fail Safe.

■ If you do not select Sample Databases, the installer does not install any sample 
database files.

Later, when you want to create a sample database, Oracle Fail Safe checks to see if 
all of the necessary sample files are located in the Oracle home where you installed 
Oracle Fail Safe. If the sample database files are not in the Oracle home, Oracle Fail 
Safe checks to see if the Oracle Fail Safe release 3.0.3 CD-ROM is online. If Oracle 
Fail Safe finds the sample files in either the Oracle home or on the CD-ROM, the 
Create Sample Database operation will succeed. Otherwise, it will return an error 
message.
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The Oracle Fail Safe release 3.0.3 installation kit includes sample databases for 
Oracle7, Oracle8, and Oracle8i database files. Oracle Universal Installer installs one 
or a combination of these files, depending on which database versions you 
currently have installed on the server node. Thus, if the node has installed only an 
Oracle7 database, then Oracle Fail Safe detects it and installs only Oracle7 sample 
database files. If the cluster node has Oracle7, Oracle8, and Oracle8i installed, then 
Oracle Fail Safe installs Oracle7, Oracle8, and Oracle8i sample database files to 
match the installed database configuration.

At this point, Oracle Universal Installer displays a window informing you to reboot 
the node at the end of the installation. (Step 8 in these instructions provides more 
information about rebooting the node.)

Step 4.  Verify the component installations in the Summary window.
Figure 2–5 shows a Summary window that lists the components selected for this 
installation.

Verify that the information in the Summary window is correct. If the summary 
includes a component that you do not want to install, click Previous to back up 
through the installation dialog.

Note: If you are performing the installation on a node that does 
not have the MSCS software installed and you choose an 
installation type that includes Oracle Fail Safe Server, the 
following error is displayed: 

Click OK to exit the error message window. Click Exit to stop the 
installation.
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Note that the Oracle Fail Safe documentation and Oracle Fail Safe quick tour are 
installed automatically and cannot be deselected.

Figure 2–5 Summary Window Showing Components to Be Installed 

If the information in the Summary window is correct, click Install to start the 
installation.

The Install window shown in Figure 2–6 displays the progress of the installation, 
including the names of the files that are being installed.

Note: If there is insufficient space on your system to perform the 
installation, the text below Space Requirements is displayed in red.
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Figure 2–6 Installation Progress Page 

Typically, installation completes in 1 to 5 minutes.

Step 5.  Enter a domain user account for Oracle Fail Safe.
If the installation is successful, the Configuration Tools window and the Oracle Fail 
Safe Account/Password dialog box shown in Figure 2–7 are displayed. 

In the Oracle Fail Safe Account/Password dialog box, enter the domain, user name, 
and password of a user account that has Administrator permissions. This is the 
account that Oracle Fail Safe Server will be using. Oracle Fail Safe Server runs as a 
Windows NT service under a user account that must be a domain user account (not 
the system account) that has Administrator permissions on all cluster nodes. Oracle 
Corporation recommends that you enter the same account information on each 
node in the cluster to avoid unnecessary Windows NT security configuration issues.

Make sure you enter the information in the form domain\username, as shown in 
Figure 2–7.
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Figure 2–7 Oracle Fail Safe Server Security Information 

Step 6.  Confirm the installation.
Oracle Universal Installer displays the End of Installation window shown in 
Figure 2–8. You can confirm the installation of the Oracle Fail Safe Server and any 
additional components by clicking Installed Products.
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Figure 2–8 End of Installation Page 

Step 7.  View the Oracle Fail Safe Release Notes.
Click Release Information to view the Oracle Fail Safe Release Notes.

Step 8.  Reboot the cluster node if this is a first-time installation.
Reboot only if this is the first time you have installed Oracle Fail Safe into a new 
Oracle home on the cluster node. You do not need to reboot the cluster node after every 
installation. However, a window will pop up during the installation procedure to tell 
you to reboot the cluster node if this is a new Oracle Fail Safe installation and you 
have installed Oracle Fail Safe Server in a new Oracle home (on a node with 
multiple Oracle homes).

If the cluster node needs to be rebooted, click Exit to quit Oracle Universal Installer 
and reboot the cluster node to ensure that all of the path information is updated 
correctly.

Note: You must wait until the first node is finished rebotting 
before you start installing Oracle Fail Safe on the second node.
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Step 9.  Verify the OracleFailSafe Service.
After you have installed the Oracle Fail Safe software on all nodes in the cluster, you 
can optionally verify that the OracleFailSafe service is running in Windows NT and 
in MSCS Cluster Administrator. See Section 2.4 for more information.

2.4 After Installation: Verify the OracleFailSafe Service
After you have installed Oracle Fail Safe Server on each node in the cluster, you can 
optionally verify the installation.

This section describes how to check for the Oracle Fail Safe Server in the Windows 
Control Panel and in MSCS Cluster Administrator on all cluster nodes.

Verifying the OracleFailSafe Service Entry
Upon successful installation of the Oracle Fail Safe Server, the Services Control 
Panel on each cluster node should include a new service entry named 
OracleFailSafe.

To verify the OracleFailSafe entry in the Services Control Panel:

1. Start the Control Panel:

Start -> Settings -> Control Panel 

2. Double-click the Services icon on the Control Panel.
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3. Scroll down to the Oracle service listings and locate the OracleFailSafe entry as 
shown in the following screen: 

The Startup status for Oracle Fail Safe is displayed as Started on the node 
where the cluster group resides, and it is displayed as Manual on the other 
cluster nodes (as shown in the screen).

4. Click Close to exit the Services Control Panel.

5. Perform steps 1 through 4 on each cluster node.

Verifying That Oracle Fail Safe Is in the Cluster Group
The Oracle Fail Safe service is maintained by MSCS. Upon successful installation of 
the Oracle Fail Safe Server on each cluster node, invoke the MSCS Cluster 
Administrator and verify that it includes the Oracle Fail Safe Server as a resource in 
the Cluster Group (the group containing the MSCS resources critical to cluster 
operation).

To verify that the Oracle Fail Safe Server is listed as a resource, start the MSCS 
Cluster Administrator, as follows:

Start -> Programs -> Administrative Tools -> Cluster Administrator 
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Click Cluster Group in the Cluster Administrator tree view to select it, and, in the 
right-hand pane, locate the Oracle Fail Safe entry in the Name column as shown in 
the following screen: 

Verifying That Any Additional Components Were Installed
Upon successful installation of the Oracle Fail Safe Server on both cluster nodes, 
invoke the MSCS Cluster Administrator and verify that it includes the cluster 
resource types for the Oracle Fail Safe Server subcomponents you selected.

The Oracle database server component displays as an Oracle Database resource 
type and the Oracle Application Server component displays as an Oracle 
Application Server resource type. Other components, such as Oracle Forms and 
Reports, are displayed as "Generic Service" in the Cluster Administrator screen.

For example, if you installed the optional Oracle database server and Oracle 
Application Server components, start the MSCS Cluster Administrator, as follows:

Start -> Programs -> Administrative Tools -> Cluster Administrator 
Installing Oracle Fail Safe 2-17



After Installation: Verify the OracleFailSafe Service
Click Resource Types in the Cluster Administrator tree view to select it, and, in the 
right-hand pane, locate the Oracle Database and Oracle Application Server entries 
in the Display Name column as shown in the following screen: 
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Getting Started

This chapter contains the following topics to help you connect to a cluster and get 
started using Oracle Fail Safe Manager:

3.1 Start Oracle Fail Safe Manager
Considering the numerous hardware and software components involved, 
configuring failover on a cluster can be a complex process. Oracle Fail Safe Manager 
provides wizards to automate the configuration process and ensure that the server 
configurations are consistent and conform to the standards required by the cluster.

After the installation, you can invoke Oracle Fail Safe Manager from the Start menu 
by choosing:

Start -> Programs -> <Oracle Home> -> Oracle Fail Safe Manager

In the example, replace <Oracle Home> with the name of the Oracle home where 
you installed Oracle Fail Safe.

3.1.1 Connect to the Cluster
Oracle Fail Safe displays the Connect to Oracle Fail Safe Cluster box dialog that 
allows you to make a connection to a cluster. The following window shows an 
example of a connection:    

Topic Reference

Start Oracle Fail Safe Manager Section 3.1

Oracle Fail Safe Manager Tutorial and Online Help Section 3.2
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Only the Cluster Alias is required input; Username, Password, and Domain are 
optional.

The following list describes the input to this dialog box:

■ Username

Enter a user name for a domain account name that has Administrator 
permissions on all nodes of the cluster where you are connecting.

■ Password

Enter the password for account specified in the Username box.

■ Cluster alias

Enter or select the alias name that was assigned when you created the cluster 
with Microsoft Cluster Service (MSCS). A cluster alias is sometimes referred to 
as a cluster name.

■ Domain

Enter the name of the domain in which the cluster participates.

Click OK or press Enter to connect to the cluster.

Once invoked, the Oracle Fail Safe Manager main window appears, as shown in 
Figure 3–1. 

Note: If you do not specify a user name, password, or domain, 
Oracle Fail Safe attempts to connect to the cluster using the account 
with which you logged on to the server node.
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Figure 3–1 Oracle Fail Safe Manager

3.1.2 Run Verify Cluster
The first time you connect to a cluster after you install Oracle Fail Safe, it prompts 
you to run the Verify Cluster operation to validate the Oracle Fail Safe installation 
and the network configuration.

(Later, you can run the Verify Cluster operation at any time by choosing 
Troubleshooting -> Verify Cluster from the Oracle Fail Safe Manager menu bar. 
This is especially useful if you later change your cluster configuration or perform 
administrative operations that affect the applications in a group, such as adding a 
tablespace or adding a new disk to a database.)

The Verify Cluster operation displays its progress in a Clusterwide Operation 
window similar to the one shown in Figure 3–2. 
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Figure 3–2 Verify Cluster Operation 

Verifies that the Oracle Fail Safe
release is identical on all nodes.

Verifies that the resource 
providers are configured 
identically on all nodes.

Verifies that the Host Name/IP 
Address mappings resolve 
consistently across all of the
nodes in the cluster.

Verifies that the Oracle homes
are identical on all nodes.
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The Oracle Fail Safe Concepts and Administration Guide describes the Verify Cluster 
operation in more detail.

3.2 Oracle Fail Safe Manager Tutorial and Online Help
For detailed step-by-step instructions about using Oracle Fail Safe Manager, refer to 
the Oracle Fail Safe tutorial and help. To access these online tools, from the Oracle 
Fail Safe Manager menu bar, choose Help -> Contents or Help -> Tutorial for 
step-by-step instructions.

The online help is your primary source of information when you use Oracle Fail 
Safe Manager. For example, if you click Contents in the Help menu, the Help 
window displays the first help topic. If you click Search for Help on, a Help 
window opens to display Contents, Index, and Find tabs (similar to what you find 
in Microsoft Windows Help). You can find common tasks under the Contents tab 
and in the Index. The Find tab allows you to perform a full text search of the Oracle 
Fail Safe Manager Help.

To view the full set of Oracle Fail Safe documentation, click Online Manuals.

In addition, first-time users might want to browse through the online quick tour, 
which provides an easy-to-follow overview of Windows NT clusters and the ways 
you can deploy highly available business solutions with Oracle Fail Safe. You can 
access the quick tour from the Windows taskbar after you have installed Oracle Fail 
Safe. Choose: Start -> <Oracle_Home> -> Oracle Fail Safe Quick Tour.
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Deinstalling Software on a Cluster

This chapter contains the following topics to help you deinstall Oracle Fail Safe:

You might want to deinstall Oracle Fail Safe, for example, if you want to remove 
older software such as Oracle Fail Safe 2.1.3, or to move Oracle Fail Safe software to 
a different disk or to another Oracle home. However, do not use the deinstallation 
instructions in this chapter as a method for upgrading the Oracle Fail Safe software 
to release 3.0.3. See Appendix A for information about performing a rolling 
upgrade.

Topic Reference

Deinstalling Oracle Fail Safe Release 3.0.n Software Section 4.1

Deinstalling Oracle Fail Safe Release 2.n Software Section 4.2

Caution: Do not remove the Microsoft 
Cluster Server (MSCS) software without first 
deinstalling Oracle Fail Safe. Removing the 
MSCS software while Oracle Fail Safe is 
running will cause all of the MSCS metadata 
to be deleted, producing undesirable results. 
See Chapter 5 for more information.
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4.1 Deinstalling Oracle Fail Safe Release 3.0.n Software
If both Oracle Fail Safe Server and Oracle Fail Safe Manager are installed in the 
same Oracle home, you can deinstall them together, as explained in Section 4.1.1. 
This is the most typical type of deinstallation.

However, you can choose to deinstall only Oracle Fail Safe Manager. There are 
special considerations for removing only Oracle Fail Safe Manager when both 
components are present. Be sure to review Section 4.1.2.

4.1.1 Deinstalling Both Oracle Fail Safe Server and Manager
Deinstalling Oracle Fail Safe involves removing resources from groups and 
reconfiguring them to run on a specific cluster node.

Perform the following steps to remove Oracle Fail Safe software.

Step 1.  Remove cluster resources from groups configured with Oracle Fail 
Safe Manager.
This step should be done only on groups that were configured with Oracle Fail Safe. 
Do not perform these steps on groups that were configured with MSCS (such as the 
Cluster Group).

Using Oracle Fail Safe Manager, perform the following steps:

1. Move each group to the node that will host the standalone resources after 
Oracle Fail Safe is deinstalled.

2. Remove all resources from your groups.

3. Delete all groups.

4. Exit Oracle Fail Safe Manager.

Step 2.  Invoke Oracle Universal Installer and deinstall components.
Insert the Oracle Fail Safe CD-ROM to invoke the Oracle Universal Installer. When 
the Autorun Welcome screen is displayed:

1. Click Deinstall Products to display an Inventory dialog box.

2. Select the Oracle home that contains the Oracle Fail Safe release 3.0.n software.

3. Expand the tree view and select the check box next to Oracle Fail Safe 3.0.n.
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Step 3.  Exit Oracle Universal Installer.
Click Exit to exit Oracle Universal Installer.

4.1.2 Deinstalling Only Oracle Fail Safe Manager
To deinstall Oracle Fail Safe Manager on a cluster node that has only Oracle Fail 
Safe Manager installed, follow the instructions in Section 4.1.1.

If you have both Oracle Fail Safe Server and Oracle Fail Safe Manager installed and 
you want to deinstall only Oracle Fail Safe Manager, you must use the Oracle 
Universal Installer Custom or Reinstall option (shown in the following figure) to 
deinstall all components and reinstall only Oracle Fail Safe Server and its selected 
components. 
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4.2 Deinstalling Oracle Fail Safe Release 2.n Software

You cannot install Oracle Fail Safe release 3.0.3 over a previous release (such as 
Oracle Fail Safe 2.0.5 or 2.1.3). If the cluster node has an older release of Oracle Fail 
Safe software installed currently, you must deinstall it. Use the following 
step-by-step instructions to perform the deinstallation.

Step 1.  Remove all resources and delete all groups.
If cluster groups and resources are running in Oracle Fail Safe Manager, delete all of 
the groups and exit Oracle Fail Safe Manager, as follows:

1. Remove all resources from the cluster groups.

2. Delete all groups.

3. Exit Oracle Fail Safe Manager.

Do not use Microsoft Cluster Administrator to delete groups that you created using 
Oracle Fail Safe Manager.

Note: If you try to deinstall only Oracle Fail Safe Manager on a 
cluster node that has both Oracle Fail Safe Manager and Oracle Fail 
Safe Server installed, do not click Deinstall Products and select 
Oracle Fail Safe Manager to be deinstalled. If you do this, Oracle 
Universal Installer will deinstall all Oracle Fail Safe components 
and subcomponents.

Note: If you are upgrading to Oracle Fail Safe release 3.0.3 from 
release 2.1.3 (or earlier), follow the instructions provided in 
Appendix A.

Note: To deinstall Oracle Fail Safe release 2.0.5, 2.1.2, or 2.1.3, you 
must use Oracle Installer (the predecessor to Oracle Universal 
Installer). You cannot use Oracle Universal Installer to deinstall 
releases of Oracle Fail Safe that were installed with Oracle Installer.
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Step 2.  Start the Oracle Installer.
To start Oracle Installer, from the Windows taskbar choose Start -> Oracle -> 
Oracle Installer. (If you do not have Oracle Installer available from the Start menu, 
it is also located on the Oracle Fail Safe CD-ROM in the \Agent80413 directory.)

This invokes Oracle Installer release 3.3.1, which is the Oracle Installer that you 
must use to deinstall Oracle Fail Safe release 2.1.3 or earlier releases. You cannot use 
Oracle Universal Installer to deinstall components that were not installed with 
Oracle Universal Installer.

Step 3.  Remove the Oracle Fail Safe components.
In the Oracle Installer Software Asset Manager dialog box, select Oracle Fail Safe 
Server, Oracle Fail Safe Manager, or both from the Installed Products window and 
click Remove to deinstall them.

Step 4.  Unregister the Oracle Fail Safe resource DLL from MSCS.
Typically, you will click Yes when you are deinstalling the Oracle Fail Safe software. 
However, the following table provides more information to help you decide 
whether to answer Yes or No when you are prompted to unregister the Oracle 
resource from the cluster.

Step 5.  Exit Oracle Installer.
Click Exit to exit Oracle Installer.

Click . . . To . . . 

Yes Unregister the Oracle database resource and remove all Oracle Fail Safe 
information from the cluster database and registry. 

This option also unregisters the Oracle database resource type from MSCS. 
Choose this option only when:

■ You do not want to use Oracle Fail Safe on any cluster node

■ You do not have any databases configured in an Oracle Fail Safe group on 
the cluster nodes

No Remove all Oracle Fail Safe files installed on this node without unregistering 
Oracle database resources and removing the Oracle database resource DLL files.

This option helps you to remove one node from the cluster while the other node 
continues to run Oracle Fail Safe. For example, you might choose this option if 
one node in the cluster fails or needs maintenance and you need to replace it with 
a different system, or if you are upgrading your Oracle Fail Safe software to 
release 3.0.3.
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Troubleshooting Installation Problems

This chapter provides general information and helpful tips to help you troubleshoot 
problems with Oracle Fail Safe installations and deinstallations. The following table 
shows the information provided in this chapter:
 

5.1 Problems with FSCMD Command After Upgrade
If you upgraded from Oracle Fail Safe release 2.1.3.0 to release 3.0.n and suddenly 
your FSCMD scripts do not work, it is probably because you need to include the 
/Cluster parameter on the FSCMD command.

Beginning with release 2.1.3.1, the /Cluster parameter is required on the FSCMD 
command. If you upgraded from release 2.1.3.0, your FSCMD scripts will not work 
and you might get an "invalid number of parameters" error message on the FSCMD 
command.

Also, the FSCMD command is now located in <Oracle_home>\fs\fsmgr\bin 
directory, where <Oracle_home> is the Oracle Fail Safe home directory. If you are not 
in that directory, you must specify the full path when running the FSCMD 
command.

Topic Reference

Problems with FSCMD Command After Upgrade Section 5.1

Error Creating Sample Database Section 5.2

Problems Installing Oracle Fail Safe Server Section 5.3

Problems Deinstalling Oracle Fail Safe and MSCS Software Section 5.4

Problems Deinstalling Oracle Fail Safe Manager Section 5.5
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5.2 Error Creating Sample Database
If you install an Oracle8i or Oracle8 database server after you installed Oracle Fail 
Safe and then you try to create a sample database, the following error message 
displays:

FS-10270 Oracle Fail Safe sample database files not found in installation 
directory or CD-ROM.

You can install sample databases when you want to create a sample database. 
During the Create Sample Database wizard, Oracle Fail Safe checks to see if all of 
the necessary sample files are located in the Oracle home where you installed 
Oracle Fail Safe. If the sample database files are not in the Oracle home, Oracle Fail 
Safe checks to see if the Oracle Fail Safe release 3.0.3 CD-ROM is online. If Oracle 
Fail Safe finds the sample files in either the Oracle home or on the CD-ROM, the 
Create Sample Database operation will succeed. Otherwise, it will return an error 
message. Optionally, you can install the sample database files in the same Oracle 
home where you install Oracle Fail Safe, or save disk space by leaving the sample 
database file on the CD-ROM.

See Chapter 2 for more information about installing sample databases.

5.3 Problems Installing Oracle Fail Safe Server 
If you are running Oracle Universal Installer on a system that does not have MSCS 
installed (such as a client system) and you try to install Oracle Fail Safe Server, the 
installer will display the warning shown in Figure 4–1.

Figure 5–1 Warning Window for Improper Server Installation 
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If the message in Figure 5–1 displays, do not continue with the installation. Click 
OK to back up through the installation windows and choose another Oracle Fail 
Safe installation type (described in Chapter 2).

5.4 Problems Deinstalling Oracle Fail Safe and MSCS Software
Chapter 4 includes a cautionary note that warns against deinstalling the MSCS 
software before you deinstall Oracle Fail Safe. If you deinstall the MSCS software on 
both cluster nodes, the cluster metadata information about Oracle Fail Safe will be 
removed.

If you deinstall MSCS from only one cluster node, the cluster metadata information 
still is available on the other node. To prevent the loss of the cluster metadata, do 
not deinstall MSCS from the other node; reinstall MSCS on the first node and click 
Join an Existing Cluster when prompted by the installation procedure to add the 
node back to the cluster and recover the cluster metadata.

If you accidentally deinstall MSCS software on both cluster nodes before you 
deinstall Oracle Fail Safe, you can recover from this problem by performing the 
following steps using Oracle Fail Safe Manager:

1. Click on the standalone resource in the Oracle Fail Safe Manager tree view.

2. Select the Verify Standalone Database operation from the Resources menu.

3. Enter the standalone database information in the Verify Standalone Database 
window.

4. When the verification completes successfully, add the standalone resource to a 
group using the Add Resource to Group wizard.

Note: It might be necessary to manually restore the configuration of other 
non-database resources, such as your Web server or application server.

5.5 Problems Deinstalling Oracle Fail Safe Manager
If you try to deinstall only Oracle Fail Safe Manager on a cluster node that has both 
Oracle Fail Safe Manager and Oracle Fail Safe Server installed, the installer will 
deinstall all of the components and subcomponents and display a window asking 
you to confirm the deinstallation. Click No.

If you have both Oracle Fail Safe Server and Oracle Fail Safe Manager installed and 
you want to deinstall only Oracle Fail Safe Manager, you must use the Oracle 
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Universal Installer Custom or Reinstall option (Section 4.1.2) to deinstall all 
components and reinstall only Oracle Fail Safe Server and its selected components.
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Performing Rolling Upgrades

Oracle Fail Safe allows a cluster system to continue to provide service while the 
software is being upgraded to the next release. This process is called a rolling 
upgrade because each node is upgraded and rebooted in turn, until both server 
nodes and all client nodes have been upgraded.You might want to perform a roll-
ing upgrade for the following reasons:

■ To upgrade other Oracle software and install patches that require you to stop 
the Oracle services being used by Oracle Fail Safe

■ To upgrade the Oracle Fail Safe software or install patches

This appendix discusses the following topics:

A.1 Preparing Users for the Upgrade
During a rolling upgrade, you need to perform a planned failover to make the clus-
ter resources running on one node move over to the other node. Each planned 
failover will disconnect users and cause rollback of any interrupted, uncommitted 
work.

This brief outage typically is less than 1 minute and always is less than the down-
time that would be experienced by users if Oracle Fail Safe was not installed. To 

Topic Reference

Preparing Users for the Upgrade Section A.1

Recommended Order for Upgrading Software Section A.2

Upgrading Oracle Database Software Section A.3

Upgrading the Oracle Fail Safe Software and Installing Patches Section A.4

Migrating an Oracle Database Section A.5
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prevent loss of work, notify users that you plan to shut down the system, and have 
all users commit their work and log off before you perform the failover. Advise 
users when they can reconnect and resume work after the database fails over to the 
other cluster node.

While you are performing upgrades to the cluster, remember that failback is dis-
abled and your cluster is not protected against failures. In addition, each time that 
you stop and restart the cluster service on a node (with Microsoft Cluster Adminis-
trator), all remaining cluster resources registered with MSCS fail over to the other 
node with a similar brief loss of service.

A.2 Recommended Order for Upgrading Software
The following list provides the recommended order for upgrading software on your 
cluster:

1. Oracle software installation or upgrade

If you need to upgrade both your Oracle database software and Oracle Fail Safe 
software, Oracle Corporation recommends that you upgrade the Oracle data-
base software first.

2. Oracle Fail Safe software upgrade

By upgrading Oracle Fail Safe after you install or upgrade your database soft-
ware, you ensure that sample database files are installed as a part of the Oracle 
Fail Safe installation. After the software upgrade, ensure that your Oracle data-
base works correctly. For example, you could add a sample database to a group 
and move it to another node.

3. Oracle database migration

If you need to migrate a database, you must first remove it from a group, per-
form the migration, and then add it back into the group.

If you need to upgrade the Oracle Application Server software from release 4.0.7 to 
release 4.0.8, you must first remove the Oracle Application Server Web listener from 
all groups, upgrade the Oracle Application Server software to release 4.0.8, and then 
create or add the Oracle Application Server resources back into the cluster groups.

A.3 Upgrading Oracle Database Software

Note: If you do not need to upgrade your Oracle product soft-
ware, skip to Section A.4. 
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This section describes upgrading Oracle software and installing patches that require 
you to stop the Oracle services being used by Oracle Fail Safe.

Although the process is the same regardless of the Oracle software you need to 
upgrade, the steps in Table A–1 use an Oracle database software upgrade as an 
example:

■ Upgrading Oracle7 release 7.3.4 to Oracle8 release 8.0.n

■ Upgrading Oracle8 release 8.0.n to Oracle8i

When you upgrade Oracle product software, do not start the installation procedure 
while any Oracle Fail Safe Manager operations or Microsoft Cluster Administrator 
operations are in progress on groups. You should wait for a quiet period in cluster 
operations before you proceed with the steps in Table A–1. Also, if you are upgrad-
ing Oracle database software, consider performing a database backup prior to any 
major upgrade.

CAUTION: To ensure minimal downtime and to identify any 
potential issues with other software that might be running on the 
cluster, Oracle Corporation recommends that you test the follow-
ing upgrade operations on an identically configured test cluster 
before you upgrade the production cluster.

Table A–1 Steps Required to Upgrade Oracle Product Software 

Step Task Tool Comments

Perform the following steps on only one cluster node at a time.

Change the group 
failback attributes to 
the Prevent Failback 
mode.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager online 
help. Changing the failback attributes prevents the group 
from failing back to the node while it is being rebooted or 
when the cluster service is restarted.

Perform a planned 
failover by moving 
groups to the other 
node.

Oracle Fail Safe 
Manager

Choose Groups -> Move to a Different Node. (See the 
instructions in the Oracle Fail Safe Manager tutorial for more 
information). By moving all of the groups to the other node, 
you can work on the current node. When moving groups that 
contain databases with this method, Oracle Fail Safe will per-
form a checkpoint operation.

1

2
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Exit Oracle Fail Safe 
Manager.

Oracle Fail Safe 
Manager

On the current node, select File -> Exit.

Note: Do not use Oracle Fail Safe Manager on either cluster 
node during the rest of the upgrade procedure until you run 
Verify Cluster in step 9.

Stop the cluster ser-
vice on the node 
where you want to 
install software.

Microsoft Cluster 
Administrator

Perform the following steps:

1. In the left pane, click to select the cluster node where the 
cluster service needs to be stopped.

2. On the File menu, click Stop Cluster Service.

Stop all running 
Oracle applications 
and all remaining 
Oracle services.

Microsoft Con-
trol Panel

From the system taskbar, click the Start button and choose: 
Control Panel -> Services

Stop all running Oracle services, including the Oracle Fail 
Safe service.

Install the new Ora-
cle product or com-
ponent software.

Oracle Installer
or Oracle Univer-
sal Installer

Follow the instructions that come with the Oracle product or 
component.

Reboot the node. Rebooting the node automatically restarts the cluster service 
on the node where you just installed the Oracle software. 
Restarting the cluster service is essential for the changes to 
take effect.

Run the Verify 
Group operation on 
all groups.

Oracle Fail Safe 
Manager

Select Troubleshooting -> Verify Group to check all of the 
resources in all groups and confirm that they have been con-
figured correctly. If you upgraded Oracle database software, 
the Verify Group will update the TNSNAMES.ORA file. 
When prompted, click Yes. Otherwise, the Oracle database 
might not come online after you add it to a group.

Repeat steps 2 through 8 on the other server node in the cluster.

Table A–1 Steps Required to Upgrade Oracle Product Software (Cont.)

Step Task Tool Comments

3

4

5

6

7

8

9
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A.4 Upgrading the Oracle Fail Safe Software and Installing Patches 
This section describes how to perform a rolling upgrade when you want to upgrade 
the Oracle Fail Safe software on a cluster that is currently running Oracle Fail Safe 
(for example, to upgrade the cluster from Oracle Fail Safe release 2.1.3 to release 
3.0.3). The methodologies described in this section are applicable for upgrades from 
any previous Oracle Fail Safe release to Oracle Fail Safe release 3.0.3.

If you are performing a rolling upgrade of the Oracle Fail Safe software, you must 
upgrade the Oracle Fail Safe Server and Oracle Fail Safe Manager software cluster-
wide; you cannot run multiple releases of the Oracle Fail Safe software on the same 
cluster (or on client machines accessing the cluster nodes).

Run the Verify Clus-
ter operation.

Oracle Fail Safe 
Manager

This step verifies that there are no discrepancies in the soft-
ware installation, such as with the release information on 
each node in the cluster.

Restore the failback 
policy attributes on 
the groups.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager online 
help to set the failback policy for all of the groups in the clus-
ter.

Fail back groups, as 
necessary, by mov-
ing groups back to 
the other node.

Oracle Fail Safe 
Manager

Perform a planned failover to move the groups back to the 
preferred node. This step rebalances the workload across the 
nodes in the cluster. Refer to the instructions in the Oracle 
Fail Safe Manager online help regarding moving a group to a 
different node.

Note: If you need to migrate an Oracle database in addition to 
upgrading the Oracle fail Safe software, Oracle Corporation recom-
mends that you first upgrade your Oracle Fail Safe software on 
both nodes in the cluster and ensure that it is working with your 
current database before you perform a database migration.

Table A–1 Steps Required to Upgrade Oracle Product Software (Cont.)

Step Task Tool Comments

10

11

12
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When you upgrade the Oracle Fail Safe software, do not start the installation proce-
dure while any Oracle Fail Safe Manager operations or Microsoft Cluster Adminis-
trator operations are in progress on groups. You should wait for a quiet period in 
cluster operations before you proceed with the steps in Table A–2.

Note: All of the systems in the cluster must run the same release 
of the Oracle Fail Safe software. For example, a system that is run-
ning Oracle Fail Safe Manager release 3.0.3 must run on a server 
node that is running Oracle Fail Safe Server release 3.0.3; it will not 
work with a server node that is running Oracle Fail Safe Server 
release 2.1.3.

CAUTION: To ensure minimal downtime and to identify any 
potential issues with other software that might be running on the 
cluster, Oracle Corporation recommends that you test the follow-
ing upgrade operations on an identically configured test cluster 
before you upgrade the production cluster.

Table A–2 Steps Required to Upgrade to Oracle Fail Safe Release 3.0.3 

Step Task Tool Comments

Perform the following steps on only one cluster node at a time.

Change the group 
attributes to the Pre-
vent Failback mode 
for all groups.

Oracle Fail Safe Man-
ager

Follow the instructions in the Oracle Fail Safe Manager 
online help. Changing the failback attributes prevents 
the group from failing back while it is being rebooted 
(later in step 6).

Perform a planned 
failover by moving 
groups (that contain 
Oracle databases) to 
the other node.

Oracle Fail Safe Man-
ager

Choose Groups -> Move to a Different Node. (See the 
instructions in the Oracle Fail Safe Manager tutorial for 
more information). By moving groups that include 
databases to the other node, you can work on the cur-
rent node. When moving groups that contain data-
bases with this method, Oracle Fail Safe will perform a 
checkpoint operation.

1

2
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Exit Oracle Fail Safe 
Manager.

Oracle Fail Safe Man-
ager

On the current node, select File -> Exit.

Note: Do not use Oracle Fail Safe Manager on either 
cluster node during the rest of the upgrade procedure 
until you run Verify Cluster in step 10.

Deinstall the previ-
ous release of Ora-
cle Fail Safe 
Manager and Oracle 
Fail Safe Server.

Oracle Installer 1. To start Oracle Installer, from the Windows task-
bar choose Start -> Programs -> Oracle for Win-
dows xx -> Oracle Installer.

2. In the Oracle Installer Software Asset Manager dia-
log box, select Oracle Fail Safe Server, Oracle Fail 
Safe Manager, or both from the Installed Products 
window and click Remove to deinstall them.

3. Click No when Oracle Installer prompts you to 
unregister the Oracle Fail Safe resource DLL from 
MSCS.

4. Exit Oracle Installer.

Install Oracle Fail 
Safe release 3.0.3.

Oracle Fail Safe installa-
tion CD-ROM

Follow the installation instructions in Chapter 2 of the 
Oracle Fail Safe Installation Guide.

Reboot the node. Windows NT On the Windows taskbar, choose Start -> Shutdown 
-> Restart the Computer.

Note: You must wait until the first node is finished 
rebooting before you start installing Oracle Fail Safe on 
the second node.

Move groups that 
contain Oracle data-
bases to the 
upgraded node.

Microsoft Cluster 
Administrator

Move cluster groups that contain Oracle databases to 
the upgraded node.

Repeat steps 4 through 6 on the other cluster node.

Install Oracle Fail 
Safe Manager on cli-
ent nodes.

Oracle Fail Safe installa-
tion CD-ROM

You must install the same release of Oracle Fail Safe 
software on both server nodes and on each client node 
where you want to run Oracle Fail Safe Manager.

Run the Verify Clus-
ter operation on the 
server nodes.

Oracle Fail Safe Man-
ager

This step verifies that there are no discrepancies in the 
software installation, such as with the release informa-
tion on each node in the cluster, and registers resource 
DLLs.

Table A–2 Steps Required to Upgrade to Oracle Fail Safe Release 3.0.3 (Cont.)

Step Task Tool Comments

3

4

5

6

7

8

9

10
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A.5 Migrating an Oracle Database
If you need to migrate a database that is configured in a group, you must first 
remove it from a group, perform the migration, and then add it back into the group.

For information about database migration, refer to the Oracle Fail Safe Concepts and 
Administration Guide and to the migration instructions documented for Oracle 
Migration Assistant.

Restore the failback 
policy attributes on 
the groups.

Oracle Fail Safe Man-
ager

Follow the instructions in the Oracle Fail Safe Manager 
online help to set the failback policy for all of the 
groups in the cluster.

Fail back groups, as 
necessary, by mov-
ing groups back to 
the other node.

Oracle Fail Safe Man-
ager

Perform a planned failover to move the groups back to 
the preferred node. This step redistributes the work-
load across the nodes in the cluster. Refer to the instruc-
tions in the Oracle Fail Safe Manager online help 
regarding moving a group to a different node.

Run the Verify 
Group operation on 
all groups.

Oracle Fail Safe Man-
ager

Select Troubleshooting -> Verify Group to check all of 
the resources in all groups and confirm that they have 
been configured correctly. See the Oracle Fail Safe Con-
cepts and Administration Guide for a description of the 
validation tests performed during a Verify Group oper-
ation.

Table A–2 Steps Required to Upgrade to Oracle Fail Safe Release 3.0.3 (Cont.)

Step Task Tool Comments

11

12

13
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B

Performing a Silent Installation

This appendix describes how to automate the Oracle Fail Safe installation by 
performing a silent installation.

The following topics are discussed in this appendix:

B.1 Introduction to Silent Mode Installations
You can install Oracle Fail Safe in silent mode, which is an installation method that 
allows you to install software by supplying input to Oracle Universal Installer in a 
file rather than through the Oracle Universal Installer graphical user interface 
(GUI). 

If you are performing multiple installations that are identical or similar to each 
other, you may want to run Oracle Universal Installer in silent mode to automate 
the installation process. You do this by editing a file, called a response file, that is 
supplied with Oracle Fail Safe.

A response file contains the answers that you typically provide in an interactive 
installation session. By providing all installation input in a response file, which you 
invoke at the command-line prompt or in batch mode, you eliminate the need for 
direct interaction from the user and a GUI is not displayed. Then, invoke Oracle 
Universal Installer and enable the response file in command-line mode or batch 
script to install Oracle Fail Safe.

Topic Reference

Introduction to Silent Mode Installations Section B.1

Editing and Enabling the Response File Section B.2

Contents of a Response File Section B.3
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Editing and Enabling the Response File
A silent installation is the only alternative to using the Oracle Universal Installer 
GUI; there is no character-mode version of Oracle Universal Installer.

B.2 Editing and Enabling the Response File
The OfsProducts.rsp response file is provided on the Oracle Fail Safe CD-ROM to 
help you set up Oracle Fail Safe installations in silent mode. The file is located on 
the CD-ROM in the \stage\Response\OfsProducts.rsp directory.

This file has been prepared to perform the Typical installation type, which installs 
Oracle Fail Safe Manager and Oracle Fail Safe Server with the Oracle database 
component, Oracle Intelligent Agent component, and the generic service 
component. The instructions in the following sections describe how to edit the 
OfsProducts.rsp file.

B.2.1 Implementation Steps
The following steps describe how to customize the variables in the OfsProducts.rsp 
file and enable Oracle Universal Installer to use the file. 

Step 1:  Copy the OfsProducts.rsp file from the CD-ROM.
Make a copy of the original OfsProducts.rsp file (located on the CD-ROM in 
\stage\Response\OfsProducts.rsp) so that you can retain the original file for use as 
a template. 

You might want to make several copies of the response file, each with a different 
purpose, and specify a different name for each one. For example, you might have a 
response file named failsafemanager.rsp that performs only Oracle Fail Safe 
Manager installations.

Step 2:  Edit the response file.
Edit the response file to specify options for your Oracle Fail Safe installation.

The OfsProducts.rsp file template contains all of the required Oracle Fail Safe 
installation variables. For example, there are variables that specify the name of the 
Oracle home where you want to install Oracle Fail Safe, the installation type 
(Typical, Complete, or Client Only), and the account user name and password for 

Note: Only use the OfsProducts.rsp file to perform silent 
installations for Oracle Fail Safe. Do not use the response file that is 
provided with Oracle Fail Safe to install any other products.
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Editing and Enabling the Response File
the Oracle Fail Safe service. See Figure B–1 for an example of a response file and the 
Oracle Fail Safe variables.

In the response file, each variable is documented using comment lines that begin 
with a number sign (#). The comments contain information about the type of the 
variable, whether the variable displays in dialog, and the function of the variable. 

The following sections describe how to perform the Typical, Complete, and Client 
Only installations. The variables used in the following sections are also documented 
later in this chapter in Table B–1 and Table B–2.

For All Installation Types: Edit the following variables to specify the name of the 
Oracle home where you want to install Oracle Fail Safe:

ORACLE_HOME

ORACLE_HOME_NAME

For a Typical Installation: To install Oracle Fail Safe Manager and Oracle Fail Safe 
Server with the Oracle database component, Oracle Intelligent Agent component, 
and the generic service component:

1. Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.0.3] 
Component section and change the value to INSTALL_TYPE="INSTALL_
TYPENAME_6" (this is the default setting).

2. Locate the DCOM1 and DCOM2 variables at the end of the file. Edit these 
variables with the account user name and password needed by Oracle Fail Safe.

For a Complete Installation: To install Oracle Fail Safe Manager and Oracle Fail 
Safe Server with all subcomponents:

1. Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.0.3] 
Component section and change the value to INSTALL_TYPE="INSTALL_
TYPE_NAME_7".

2. Locate the DCOM1 and DCOM2 variables at the end of the file. Edit these 
variables with the account user name and password needed by Oracle Fail Safe.

Note: For Oracle Fail Safe release 3.0.3, you can perform only a 
Typical, Complete, or Client Only installation. You cannot perform 
a Custom installation as a silent-mode installation.
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For a Client Only Installation: To install Oracle Fail Safe Manager only, locate the 
INSTALL_TYPE variable in the [oracle.failsafe.complete_3.0.3] Component section 
and change the value to INSTALL_TYPE="INSTALL_TYPE_NAME_9".

Step 3:  Invoke Oracle Universal Installer in silent mode.
On each system where you want to install Oracle Fail Safe, invoke Oracle Universal 
Installer using the following command syntax at the command-line prompt or in a 
batch file:

E:\install\setup.exe -responseFile filename -silent -nowelcome

In the example, assume that E: is the drive letter for the CD-ROM. The following list 
explains the syntax in the command line:

■ setup.exe invokes Oracle Universal Installer.

■ -responseFile indicates that you are supplying a response file for this 
installation.

■ filename specifies the full path name of the response file that you want to use 
to provide input to Oracle Universal Installer.

■ -silent indicates that you want to run Oracle Universal Installer in silent 
mode.

■ -nowelcome is an optional command parameter that suppresses the welcome 
dialog that typically displays during an installation. 

For example, the following command performs an Oracle Fail Safe installation in 
silent mode by reading all of the required installation information from the 
failsafemanager.rsp file:

E:\install\setup.exe -responseFile D:\admin\failsafemanager.rsp -silent -nowelcome

B.2.2 Validation of Values from the Response File
During an installation session when a variable is initialized, Oracle Universal 
Installer reads the response file to see if a value has been assigned for the variable. 
Oracle Universal Installer retrieves and uses values from the response file according 
to the conditions described in the following table:

If . . . Then . . . 

The response file does not contain values 
for one or more required variables

Oracle Universal Installer stops the 
installation. 
B-4 Oracle Fail Safe Installation Guide



Contents of a Response File
B.2.3 silentInstall.log File
When you perform a silent installation, the success or failure of the installation is 
recorded in the file C:\temp\silentInstall.log.

Oracle Universal Installer does not write to the log file until after the silent 
installation has completed.

B.3 Contents of a Response File
The rest of the sections in this appendix describe the contents of the OfsProducts.rsp 
file that is provided with Oracle Fail Safe. You can use the response file, located in 
<Oracle_Home>\Response\OfsProducts.rsp, as a template. Edit the variables in the 
file to contain the responses you would need to provide during the Oracle Fail Safe 
installation session. Use the following format when you specify values for variables 
in the response file:

variable name = <recommendation> : value

Set the variable name and value parameters as described in Tables B–1 and B–2. Set 
the optional <recommendation> variable to either Forced or Default, as follows:

■ Forced—does not display the setting for the value parameter during installation; 
the user cannot change any variable values during the silent installation.

■ Default—displays the default setting for the value parameter during the 
installation and allows the user to choose another value.

The OfsProducts.rsp response file contains three sections: General, Session, and one 
or more Component sections, as shown in Figure B–1. Each section begins with a 
line that specifies the section name in brackets (for example, the General section 
begins with [General]).

Any variables specified in the response 
file contain invalid context, format, or 
type values

Oracle Universal Installer ignores the 
specified value.

Any variables are specified outside of any 
response file section

Oracle Universal Installer ignores the 
variables.

If . . . Then . . . 
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Figure B–1 OfsProducts.rsp File 

General

Session

Component
Component sections can be:

oracle.failsafe.server_3.0.3
oracle.failsafe.complete_3.0.3

oracle.failsafe.databases_3.0.3
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B.3.1 General Section
The General section is an informational section that contains the version number of 
the response file. There is only one General section per response file. For example:

[General]
RESPONSEFILE_VERSION=1.6.1.0.0

Do not edit information in the General section.

B.3.2 Session Section
The Session section lists predefined (generic) dialogs for Oracle Universal Installer 
and shows whether the dialogs are visible to the user.

Oracle Universal Installer displays the dialog when the value is set to true, and does 
not display the dialog when a value is set to false. For example:

[SESSION]
SHOW_INSTALL_PROGRESS_PAGE=true

Because the SHOW_INSTALL_PROGRESS_PAGE is set to true, the progress of the installation 
will be displayed during the installation. The Session section also lists global 
variables that are set during one installation session (from the start of the 
installation to the end of installation). These variables include top-level components 
and languages. 

Table B–1 provides an alphabetical listing of the variables in the Session section.

Note: This section is relevant only if you do not specify the -silent 
qualifier on the command line. The -silent qualifier overrides all of 
the variable values in the Session section and does not display any 
of the installation dialog boxes.
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Table B–1 Variables for the Session Section 

Variable Name Value Type Required?

FROM_LOCATION Specifies the "From" location in the installer, 
which is a directory path containing the source 
of the products to be installed.

String Yes

ORACLE_HOME Specifies the "To" location in the installer 
where products are to be installed. For 
example, “C:\OFS30” (use quotation marks).

String Yes

ORACLE_HOME_NAME Specifies the name of the current Oracle home. 
For example, “OracleFailSafe30” (use 
quotation marks).

String Yes

SHOW_COMPONENT_LOCATIONS_PAGE Allows you to specify an alternate directory 
location for the installation. Specify false to 
prevent users from changing the location of 
the installation directory.

Boolean No

SHOW_CUSTOM_TREE_PAGE Displays only during a custom installation. On 
this page, dependencies can be selected or 
deselected. Set the value to true if you want to 
show the custom tree page in the installer and 
allow dependencies to be selected or 
deselected. Specify false to suppress it.

Boolean No

SHOW_END_SESSION_PAGE Displays the install success/failure page at the 
end of an installation. Set the value to true to 
show the page. Specify false to suppress it.

Boolean Yes

SHOW_INSTALL_PROGRESS_PAGE Displays the current status (including which 
product is being installed, which file is being 
copied) during the installation. Set the value 
to true to show the current status. Specify false 
to suppress it.

Boolean No

SHOW_OPTIONAL_CONFIG_TOOL_PAGE Displays the optional configuration tools that 
are a part of this installation, including the 
status of each tool and any tool failures that 
were detected. Set the value to true to show 
the page. Specify false to suppress it.

Boolean No

SHOW_REQUIRED_CONFIG_TOOL_PAGE Displays the required configuration tools that 
are a part of this installation, including the 
status of each tool and any tool failures that 
were detected. Set the value to true to show 
the page. Specify false to suppress it.

Boolean No
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B.3.3 Component Section of the Response File
The response file can contain one or more of the following Oracle Fail Safe 
component sections:

[oracle.failsafe.complete_3.0.3]
[oracle.failsafe.databases_3.0.3]
[oracle.failsafe.server_3.0.3]

To find a value for a variable, the Oracle Universal Installer checks the appropriate 
component section to which the variable belongs. Table B–2 describes the variables.

SHOW_SUMMARY_PAGE Lists the components that will be installed in 
this session. Set this value to true to display 
the summary page during the silent 
installation. Specify false to suppress it.

Boolean Yes

TOPLEVEL_COMPONENT Specifies the name of the Oracle Fail Safe 
component and version as a string list. Specify 
the components as a pair of strings: the first 
one represents the internal name and the 
second represents the version. For example, 
{“oracle.failsafe.complete”,”3.0.3”}.

StringList Yes

UNIX_GROUP_NAME Specifies the UNIX group name to be set for 
the inventory in UNIX platforms. This 
variable is applicable only to Oracle Fail Safe 
installations that are performed on UNIX 
systems. This variable will be ignored if you 
are performing a Windows NT installation.

String No

Table B–1 Variables for the Session Section (Cont.)

Variable Name Value Type Required?
Performing a Silent Installation B-9



Contents of a Response File
Table B–2 Variables for the Component Section 

Variable Name Value Type Required?

COMPONENT_LANGUAGES Specifies the languages for the installation. Specify 
“en” for English or “ja” for Japanese. For example:

COMPONENT_LANGUAGES={“en”}

Stringlist Yes

DCOM1 Enter the domain and user name for an account 
(entered as domain\username) that has Administrator 
permissions. For example:

DCOM1=“OFSDomain\smith”

String Yes

DCOM2 Enter the password for the account you specified with 
the DCOM1 variable. For example:

DCOM2=“myadminpassword”

String Yes

DEPENDENCY_LIST Specifies the dependent components that you want to 
install with Oracle Fail Safe. You specify the list of 
components using an internal name and version 
number. For example, the value can contain any 
combination of the following components:

DEPENDENCY_LIST={“oracle.failsafe.databases_3.0.3”, 
”3.0.3”,”oracle.failsafe.emagent”,”3.0.3”,”oracle.fa
ilsafe.forms”,”3.0.3”,”oracle.failsafe.reports”,”3.0
.3”,”oracle.failsafe.genericservice”,”3.0.3”,”oracle
.failsafe.iis”,”3.0.3”}

StringList Yes

INSTALL_TYPE Specify the internal name for only one of the 
following installation types:

Installation Type             Internal Name                         

Typical                                INSTALL_TYPE_NAME_6

Complete                           INSTALL_TYPE_NAME_7

Client Only                        INSTALL_TYPE_NAME_9

For example: INSTALL_TYPE="INSTALL_TYPE_NAME_6"

String Yes

OPTIONAL_CONFIG_TOOLS Specifies the security configuration tool that must be 
started when you install Oracle Fail Safe Server. 
Specify it using the internal name and external name, 
as follows:

OPTIONAL_CONFIG_TOOLS={"configtool1”}

Stringlist Yes
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CAUTION: Because the OfsProducts.rsp file specifies the domain, 
user name, and password information in the DCOM1 and DCOM2 
variables, make sure that you delete the OfsProducts.rsp file after 
the installation completes. Also, consider implementing other ways 
limit access to the directory that contains this file.
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Manually Registering Oracle Resource DLL

Files

Oracle Fail Safe provides resource dynamic link library (DLL) files for the Oracle 
database server and Oracle Application Server. The DLL files enable the Cluster 
Service to communicate and manage these Oracle resources. Other Oracle resources 
that do not require specialized DLL files, such as Oracle Forms and Reports, are 
managed as Generic Services.

The following topics are discussed in this appendix:

C.1 Oracle Resource DLL Files
Oracle Fail Safe Server includes the resource DLL files shown in Table C–1. These 
files enable MSCS to communicate with and manage Oracle resources.

Topic Reference

Oracle Resource DLL Files Section C.1

Registering and Unregistering the Oracle Resource DLL Files Section C.2
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Oracle Resource DLL Files
As with other cluster resources, you can apply all of the advanced properties of con-
trolling the failover parameters to these Oracle resources. You can control:

■ How often MSCS should poll the Oracle resource health (Looks Alive, Is Alive 
polling intervals)

■ Whether a resource should be restarted when it fails, and, if so, how many 
times MSCS should attempt to restart it before failing over to the other node

■ How long MSCS should wait before declaring failure of the resource (pending 
timeout) during the startup and shutdown of the resource

If the resource takes longer than the time you specified with the pending time-
out parameter to come online or go offline and the resource DLL did not detect 
any problems in the online or offline process, the resource DLL asks MSCS to 

Table C–1 Oracle Resource DLL Files

File Type Description

FsResOas.dll Oracle Applica-
tion Server

Provides functions to allow the cluster to bring an Oracle Applica-
tion Server online and check the health of the Oracle Application 
Server. There is only one Oracle Application Server running per 
Oracle Application Server installation. So, if you have multiple 
Oracle Application Server cluster resources from the same Oracle 
home, they all point to the same Oracle Application Server. For this 
reason, the offline operation currently does not bring the resource 
offline.

FsResOasEx.dll Oracle Applica-
tion Server 
resource admin-
istration exten-
sion DLL file

Used by the Cluster Administrator to display the properties of the 
Oracle Application Server resource.

FsResOdbs.dll Oracle database 
resource DLL 
file

Provides functions to allow the cluster to bring an Oracle database 
online or offline and check the health of the database through 
IsAlive polling. When the database is online, the Oracle database 
resource DLL guarantees that the database is accessible by the cli-
ent. Otherwise, the Is Alive polling fails.

FsResOdbsEx.dll Oracle database 
resource admin-
istration exten-
sion DLL file

Used by the Cluster Administrator to display the properties of the 
Oracle database resource.
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give it more time to complete the process. Thus, you do not have to be con-
cerned if a resource occasionally takes longer to come online or go offline.

C.2 Registering and Unregistering the Oracle Resource DLL Files
Typically, the Oracle Fail Safe Verify Cluster operation automatically verifies the 
Oracle resource DLL files and their registration with the MSCS software. If the Ver-
ify Cluster operation finds that the DLL files are not registered, it registers them 
with the MSCS software.

If the Oracle resource DLL files are not registered properly, you can also use the 
commands in Section C.2.1 and Section C.2.2 to manually register or unregister 
them. Invoke the commands in either of the following ways:

■ Set your default to <Oracle_Home>\fs\fssvr\bin\ before you enter any of the 
following commands. For example:

cd <Oracle_Home>\fs\fssvr\bin\
fssvr /register "Oracle Database" FsResOdbs.dll

■ Include the full path when you enter any of the following commands. For 
example:

<Oracle_Home>\fs\fssvr\bin\fssvr /register "Oracle Database" FsResOdbs.dll

The examples in following sections use the first method.

For more information about these commands, enter the fssvr \? or the fsregadm \? 
command at the command-line prompt.

C.2.1 Oracle Resource DLL Files
To register the Oracle resource DLL files, use the following commands:

fssvr /register "Oracle Database" FsResOdbs.dll
fssvr /register "Oracle Application Server" FsResOas.dll

To unregister the Oracle resource DLL files, use the following commands:

fssvr /unregister "Oracle Database"

Note: If MSCS is unable to bring an Oracle resource online, or if 
the Is Alive polling fails, the Oracle resource DLL logs a Windows 
NT event under the OracleFailSafe application to indicate the rea-
son.
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fssvr /unregister "Oracle Application Server"

C.2.2 Oracle Resource Administrator Extension DLL Files
To register the Oracle resource administrator extension DLL files, use the following 
commands:

fsregadm /r FsResOdbsEx.dll
fsregadm /r FsResOasEx.dll

To unregister the Oracle resource administrator extension DLL files, use the follow-
ing commands:

fsregadm /u FsResOdbsEx.dll
fsregadm /u FsResOasEx.dll

If MSCS Cluster Administrator is installed on the local node and the node is not a 
member of a cluster, you need to register the Oracle database resource administra-
tor extension DLL with the cluster so that you can view Oracle database resource 
parameters from the Cluster Administrator. To register, use the fsregadm com-
mand. For example:

fsregadm /r /c Cluser1 FsResOdbsEx.dll

You must specify the cluster name with the /c option or the command will fail.
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Cluster Configuration and Setup

This appendix describes some of the hardware configuration and setup tasks that 
you or your network administrator should perform before installing the cluster and 
Oracle Fail Safe software.

The following topics are described in this appendix:

D.1 Client Installation of the Domain Name Service
There are multiple ways in which network nodes can resolve IP host names to 
physical addresses. This appendix shows how to install a Domain Name System 
(DNS) server onto the Primary Domain Controller (PDC). In many cases, this is the 
best option because DNS allows centralized control of the mappings between IP 
addresses and host names.

D.1.1 Installing DNS Software
On the client Primary Domain Controller (PDC) computer, double-click the 
Network icon in the Control Panel to display the Network Control Panel. 

Task Reference

Client Installation of the Domain Name Service Section D.1

Shared Storage Configuration Section D.2

Cluster SCSI Device Configuration Section D.3

Adding a Cluster Node to the PDC Domain Section D.4

Partitioning and Formatting the Shared Storage Devices Section D.5

Synchronizing Shared Storage Drive Letters Section D.6
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Client Installation of the Domain Name Service
Click the Services tab in the Network Control Panel to display the installed services 
and determine whether or not you need to install the DNS server. 
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The DNS Server is absent from the list of network services in the Network Control 
Panel example. If the DNS server is not installed, click Add… to choose the DNS 
Server from an option list.

After clicking OK to continue with the installation of the DNS server, enter the path 
to the Windows NT installation files (as shown in the next figure) if the files were 
not found automatically. 
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Client Installation of the Domain Name Service
The Services tab in the next Network window shows that the DNS server has been 
installed. 

Click Close to exit the Network Control Panel. Click Yes in the Network Settings 
Change dialog box to reboot the system and enable the changes to take effect.   
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D.1.2 Configuring the DNS Server
After restarting the system and logging in as the Administrator, start the DNS 
Manager from the Administrative Tools folder by choosing: 

Start -> Programs -> Administrative Tools -> DNS Manager

Choose DNS ->New Server… from the menu. Enter the host name of the DNS 
server (for example, ntss-mobile is used in this guide) in the Add DNS Server dialog 
box. Click OK to create the new DNS server. 

From the left pane of the Domain Name Service Manager main window, 
double-click the Server List icon if the new DNS server icon does not appear. Select 
the entry for the client computer (ntss-mobile). 
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Client Installation of the Domain Name Service
Select DNS -> New Zone… from the menu. Create a new zone for the client 
computer by selecting the Primary radio button and clicking Next. 

In the Zone Info dialog, enter the domain name for the network segment (for 
example, us.oracle.com), accepting the default naming convention for the host file. 
Click Next to proceed. 
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Client Installation of the Domain Name Service
Click Finish to complete the configuration of the DNS zone. 

Select the new zone (domain) that was just created so that subsequent operations 
will operate against it. If no entries for the selected zone display in the right pane, 
double-click the zone. 
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Client Installation of the Domain Name Service
Add entries for the IP address mappings to be used for the cluster nodes and Oracle 
Fail Safe (see Section 1.3).

To add a host entry to the selected zone, choose DNS -> New Host… from the 
menu, and then enter the appropriate host name and IP address. Click Add Host to 
save the addition. 

Continue adding hosts until all of the host names have been defined. Click Done to 
close the New Host dialog box. 
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Choose DNS -> Update Server Data Files to save the new host additions to the 
zone file. Exit the DNS Manager.

Once the DNS service has been fully configured on the PDC, update the TCP/IP 
protocol configurations on all of the cluster nodes that should use the new DNS 
server for host name resolution.

For example, on the client computer start the Network Control Panel. Select the 
Protocols tab and double-click TCP/IP Protocol. 
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Client Installation of the Domain Name Service
Select the DNS tab and add a new DNS entry that points to the client computer (for 
example, ntss-mobile) by clicking Add in the DNS Service Search Order group. 
Make the new entry the primary DNS server by selecting it and clicking the up 
arrow until the new entry is at the top of the DNS server list.

The next figure shows the Microsoft TCP/IP Properties screen after adding the new 
DNS server (139.185.118.191) for ntss-mobile. 
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Double-click OK to close the Network Control Panel dialog box.

Repeat this procedure to define the new primary DNS server on all of the other 
systems in the cluster.

D.2 Shared Storage Configuration
A Windows NT cluster is unique in the fact that two independent nodes are 
connected to the same shared storage subsystem bus (for example, SCSI or Fibre 
Channel). The cluster nodes share access to the shared storage, though in a shared 
nothing cluster architecture only one node at a time can directly mount individual 
physical devices (or logical volumes in the case of RAID storage).

Although from a logical perspective most clusters are similar, the specific 
configuration requirements can vary considerably from vendor to vendor. Ensure 
that you correctly connect all shared cluster storage to the cluster nodes and install 
all needed cluster storage drivers and firmware according to the hardware vendor’s 
instructions. For cluster systems using SCSI devices, ensure that there is proper 
termination of the SCSI bus.
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D.3 Cluster SCSI Device Configuration
If your cluster uses SCSI storage devices, ensure that the SCSI IDs for the storage are 
configured correctly. Each SCSI device on the same bus must have a unique ID, 
including SCSI controllers. If SCSI IDs are not unique between devices, data 
corruption and I/O errors will result due to the inability to resolve packet 
destinations.

Assign each SCSI storage device a unique SCSI ID, typically between ID 0 and ID 5 
(inclusive). Also, verify that each SCSI adapter on the bus is set to a unique SCSI ID. 
For many systems, SCSI ID 6 and ID 7 are reserved for the adapters (one adapter 
per bus per system).

D.4 Adding a Cluster Node to the PDC Domain
MSCS cluster membership requires the use of a Windows NT domain account. 
Before any of the cluster nodes can authenticate using the assigned domain account, 
the node first needs to be added to the domain.

On each of the cluster nodes, start the Network Control Panel to join the 
appropriate Windows NT domain. If the Identification tab shows that the cluster 
node is not a member of the proper Windows NT domain, click Change. 
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In the Identification Changes dialog box, enter the appropriate Windows NT 
domain name for cluster membership authentication. Use the Cluster Administrator 
account to add the node to the domain. Click OK to proceed. 

If the node successfully joins the domain, a dialog box similar to the following 
screen will be displayed. 

Click OK to proceed.

The next screen shows the Network Control Panel display after the computer joins 
the Windows NT domain. Notice that NTSS_CLUSTER is now identified as a 
Domain instead of a Workgroup. 
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After the system restarts, log in to the node using the Cluster Administrator domain 
account, specifying the NT domain rather than the local security accounts database. 
The following figure uses the Cluster Administrator domain account and specifies 
the NTSS_CLUSTER domain.

D.5 Partitioning and Formatting the Shared Storage Devices
Until cluster services are installed on the nodes, there is no reliable way for the 
nodes to share access to shared storage devices. Until this point in the setup, 
therefore, the shared storage devices should be powered down to avoid possible 
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risk of data corruption, because without the cluster software, both nodes are able to 
write simultaneously to the storage.

In one of the last remaining steps before installing MSCS, the shared storage needs 
to be partitioned and NTFS-formatted. Because the cluster nodes should not try to 
simultaneously access the shared storage, these disk operations will be performed 
by only one node while the other one remains powered down.

Note that some vendors provide specialized storage-management software. If your 
vendor provides such software for use with your cluster, you should follow the 
instructions your vendor provides instead of the steps in this section.

D.5.1 Power Down Client Nodes
Ensure that all storage cabling is connected and that all drivers and device IDs have 
been properly configured. Shut down the nodes. The PDC, of course, is unaffected 
by these operations and should remain in operation.

D.5.2 Power Up the Shared Storage Devices and the Primary Node
Choose one of the nodes to perform the disk operations. Power up the shared 
storage devices and then power down the primary node.

Once you have logged in to the primary node, start the Disk Administrator in the 
Administrative Tools folder. From the Windows taskbar, choose:

Start -> Programs -> Administrative Tools -> Disk Administrator 

Because this is the first time that Disk Administrator has been run, an alert similar 
to the one in the following screen is displayed. 

Click OK to proceed. 

If the storage devices have never been partitioned by Windows NT, additional 
dialog boxes might prompt you for permission to write signature information to the 
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boot tracks of the disks. Affirm these dialog boxes; the storage devices will be 
unusable otherwise.

D.5.3 Partition Physical Disks (or RAID Logical Volumes)
The following sections describe how to format each physical disk of the shared 
storage (or logical volume when using RAID) into a single NTFS partition.

D.5.3.1 Unpartitioned Disks
The main window of the Disk Administrator should display graphical listings of 
the shared storage devices. If the devices are unpartitioned, as depicted in the 
following screen, select one of the device entries.

The following figure shows the Disk Administrator main window with a storage 
device (Disk 1) selected. 

Choose Partition -> Create from the menu. Because MSCS requires that the entire 
physical disk (or logical volume in the case of RAID storage) be dedicated to a 
failover unit, retain the default partition size value in the subsequent dialog (the 
maximum storage space allowed for the partition). The unit of failover for the 
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MSCS software is a physical disk, although you can create multiple logical 
partitions on the disk. 

Click OK to save the configuration parameters for the new partition. Depending on 
the size of the partition, a dialog box warning of possible incompatibilities with 
MS-DOS may be displayed. 

MSCS requires the use of NTFS volumes. Thus, MS-DOS compatibility is not 
possible. After you click Yes, the partition information changes are saved but not 
yet committed. Before you commit the changes, partition any other shared storage 
devices.

The Disk Administrator main window is displayed after you define new partitions. 

Note: Because MSCS requires a maximum of one partition per 
physical disk (or logical RAID volume), extended partitions are not 
needed. Thus, primary partitions are used by default in this 
chapter.
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Once all of the device partitions have been defined, choose Partition -> Commit 
Changes Now... from the menu to create the actual partitions on the disk devices. 
Click Yes in the Confirm dialog box to proceed.

The next screen shows the dialog box that alerts you to the configuration changes. 
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After you click OK, the Disk Administrator (in the next screen) displays the shared 
storage devices as being partitioned but unformatted. 

Proceed with formatting the new partitions as described in Section D.5.4.

D.5.3.2 Disks with Single Partitions
If the shared storage devices (or some combination therein) already have been 
partitioned such that the partition is sized to the capacity of the physical disk (or 
RAID logical volume), they do not need to be repartitioned.
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These partitions should still be formatted to ensure that they do not retain leftover 
data. Proceed with formatting as described in Section D.5.4.

D.5.3.3 Disks with Multiple Partitions
Because MSCS can only fail over an entire physical disk (not individual disk 
partitions), MSCS requires that each physical disk device (or logical RAID volume) 
consist of only a single partition. A given disk can be mounted only by a single 
node. Therefore, having multiple partitions on a single device does not increase 
availability because the whole disk fails over.

In general, if any of the shared storage devices have multiple partitions, all of the 
existing partitions should be deleted and replaced with a single partition that 
encompasses the entire storage capacity of the disk device. However, in some cases, 
you might want to use multiple logical partitions on a physical disk. For example, 
you can reduce backup times by separating read-only and read/write data into 
separate partitions, because only the read/write partition needs to be regularly 
backed up.

The discussion that follows assumes that you do not use multiple logical partitions 
per physical disk drive. The following screen provides an example of the Disk 
Administrator main window showing a disk (Disk 2) with multiple partitions. 
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Delete a partition by selecting it and then choosing Partition-> Delete. Click Yes on 
the subsequent dialog box to confirm the action.

 

After deleting all of the partitions, create a new partition as described in 
Section D.5.3.1.

D.5.4 Format Partitions As NTFS Volumes
To format a partition, first select it and then choose Tools -> Format... from the Disk 
Administrator menu. Specify NTFS as the file system and optionally give the 
volume a label. Click Start to proceed with the formatting. 

Note: You should delete any non-NTFS partitions on the cluster 
disks.
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Click OK in the following dialog box warning of a possible unrecoverable loss of 
data due to the formatting process. 

The following alert message is displayed when the volume formatting is done. Click 
OK to return to the Format dialog. 

Note: The volume label is arbitrary but the name Quorum was 
chosen in this case to serve as a flag that this particular volume will 
be used to contain the MSCS reliable repository.
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Click Close in the Format dialog box to return to the Disk Administrator main 
window. 

Format the remaining partitions of the shared storage devices. Upon completion, 
the main window of the Disk Administrator should look similar to the next screen. 
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Exit the Disk Administrator.

D.6 Synchronizing Shared Storage Drive Letters
Disk properties on nonclustered nodes are stored locally. This allows the possibility 
for variances between the disk properties on two nonclustered nodes when they 
individually mount a given set of shared storage devices.

Before creating an MSCS cluster, ensure that the drive letter assignments between 
the nodes match. This is not a strict requirement, but it will serve to reduce 
confusion about device identification.

If you are using nodes with similar (or identical) configurations, choose some 
convention for the drive letters. For example, allow local volumes to be mapped to a 
contiguous range of drive letters beginning with C:, putting CD-ROMs at the end of 
the list. Shared storage devices are then mapped to drive letters beginning after the 
local range.
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Start the Disk Administrator from the Administrative Tools folder. To change the 
drive letter assignment of a volume, select the volume and then choose Tools -> 
Assign Drive Letter... from the menu. 

The following figure shows the Assign Drive Letter dialog box with the available 
drive letter choices displayed in a pull-down menu. 

Note: Although the private disks do not need to have drive letters 
that are synchronized, you must assign the same drive letters to the 
shared cluster disks across all of the cluster nodes.
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Once you have chosen a new drive letter, click OK. Assuming that no open files are 
on the volume (for example, the Windows NT paging file), a dialog box will be 
displayed to confirm the drive letter change. 

The following confirmation window is displayed when you change the drive letter 
assignment of a volume. 

To follow the drive letter convention described at the start of this section, some 
drive letter shuffling is required. For example, one sequence of drive letter changes 
might be to:

■ Change Disk 1 from drive letter D: to G:

■ Change CD-ROM 0 from drive letter F: to D:

■ Change Disk 2 from drive letter E: to F:

■ Change Disk 1 from drive letter G: to E:

Verify that the updated volume configuration matches the desired convention.
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The following Disk Administrator main window shows the updated drive letter 
assignments. 

Shut down and power down the first node and start the second node. Once you 
have logged in to the second node as the domain-authenticated cluster membership 
account, start the Disk Administrator and synchronize the drive letter mappings 
with the first node. While not mandatory, this step will alleviate potential drive 
reference confusion in the future.

After you successfully synchronize the volume drive letter mappings on the second 
node, shut it down and power it down. Start the first node for the installation of 
MSCS.
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Installing Cluster Software

This chapter provides a step-by-step walkthrough of installing Microsoft Cluster 
Server (MSCS) software. A new MSCS cluster can be created once all preliminary 
setup requirements have been met.

The following topics are described in this appendix:

E.1 Before You Install Checklist
Perform the following checklist items before beginning the installation procedure:

❏ Create a cluster membership account; Section D.4 describes how MSCS cluster 
membership requires the use of a Windows NT domain account.

❏ Boot one of the cluster nodes and log in to the domain using the cluster 
membership account. 

❏ Power on and mount the shared cluster storage devices on the first node.

❏ Power off the second node.

Procedure Reference

Before You Install Checklist Section E.1

Start the Enterprise Edition Installer Section E.2

Install MSCS on the First Node Section E.3

Install MSCS on the Second Node Section E.4

Install the Cluster Administrator on Client Systems Section E.5

After Installation: Verify the Cluster Service Section E.6
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Start the Enterprise Edition Installer
Do not have both systems running until you have installed the MSCS software on 
one of the systems. By doing so, you prevent contention for the shared disk devices. 
After you install MSCS on the first node, it will prevent the other planned cluster 
member from accessing the shared disks until the MSCS software is installed 
successfully on both nodes.

E.2 Start the Enterprise Edition Installer
The Microsoft Windows NT Server Enterprise Edition 4.0 Installer must be used to 
install Microsoft Cluster Server. (Note that this software is usually located on the 
second CD-ROM in the kit.) The MSCS software runs as a Windows NT service.

Start the installer using either of the following methods:

■ Load the Windows NT Server Enterprise Edition CD-ROM in a drive. Then, 
invoke the installer by double-clicking setup.exe located in the <CD-ROM_
drive_letter>:\MSCS\cluster\i386 folder, as shown in the following figure: 

In the figure, D: is the drive letter for the device where you loaded the CD-ROM 
media.
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■ From the Windows taskbar, start the Enterprise Edition Installer from the 
Administrative Tools shortcut folder and access the Windows NT Server 
Enterprise Edition 4.0 installer. 

Double-click Enterprise Edition Installer to invoke the NHLOADER.EXE 
installation program, which is included with Windows NT to install the 
optional products that ship on Disk 2 of the Windows NT Server Enterprise 
Edition distribution kit.

E.3 Install MSCS on the First Node
Although you must install MSCS on each cluster node, perform the installation on 
only one node at a time. 

Step 1.  Close any open applications.
After you start the installer, the Microsoft Cluster Server setup displays the 
Welcome screen shown in the next figure. Before you continue, close any running 
Windows NT applications to ensure that the installer will not encounter any file 
permission errors due to open files. Do not open applications during the installation 
of the MSCS software.

Click Next to proceed with the MSCS setup. 
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Step 2.  Validate the cluster hardware configuration.
In the next screen, click I Agree to confirm that your cluster hardware configuration 
conforms to the Microsoft requirements. Click Next to proceed. 

Step 3.  Create a new cluster.

In the next screen, you choose whether this installation will create a new cluster or 
join an existing cluster. Because this installation is being performed on the first node 
of a new cluster, select Form a new cluster. Click Next to proceed. 
E-4 Oracle Fail Safe Installation Guide



Install MSCS on the First Node
Step 4.  Specify the cluster alias name.
Specify the name of the cluster to be created. The name, known as a cluster alias, is 
a unique network node identifier for all of the nodes in the cluster. The name can be 
a maximum of 15 characters. 

Click Next to proceed. 
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Step 5.  Specify the target location of the cluster files.
The MSCS executable files (not the quorum files) are installed, by default, into a 
new subdirectory within the Windows NT %SystemRoot% directory. Accept the 
default location or enter an alternative target location for the cluster files. The target 
location that you specify must be on a local (private) disk, not a cluster disk.

Click Next to proceed. 

Step 6.  Enter the domain account information for the Cluster Service.
The MSCS Cluster Server runs as a Windows NT service. Enter the authentication 
information for the domain account used for the cluster membership. The account 
you specify requires Administrator permissions on the local node.

Click Next to proceed. 
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Step 7.  Configure the shared disk devices.
In the next screen, you configure MSCS to use specific shared disk devices. 

The installation program displays all of the available devices that are on shared 
controllers. Verify that the shared disk devices are listed in the right-hand column 
and remove any disks that are not going to be used by the cluster. 

Click Next to proceed. 
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Step 8.  Select the quorum disk location.
The cluster software needs to store its metadata on a shared cluster disk so that, in 
the event of failure, either of the cluster nodes can access the metadata. This disk, 
called the quorum disk, is located on the cluster disks and contains the metadata 
that is necessary for recovery after failures. 

When you select a disk to be the quorum disk, use the smallest disk drive. The disk 
you choose should not go offline or be vulnerable to corruption. Thus, try not to use 
a large disk because its size could incur a performance problem, and try not to use a 
disk on which a large resource, such as an Oracle database, resides. In general, it is 
best to have a separate dedicated storage disk for the quorum resource, for each 
independent database workload, and for each independent application workload 
resource that will be deployed on the cluster.

Click Next to proceed.

Step 9.  Search for network adapters in the cluster.
The next screen searches for all of the network adapters in the cluster, and 
configures the network properties for the new cluster. Click Next to begin a search 
for network adapters. 
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Step 10.  Configure private or public network communications.
When the search process has completed, the next dialog box asks you to configure 
the type of communications you want to allow for a particular network adapter. 

In a simple case of a node with a single network adapter, all network 
communications (for example, the cluster interconnect traffic as well as generic 
LAN access) must use the single network adapter. For a node with multiple 
network adapters, some amount of separation and redundancy of duties will yield 
better overall performance and reliability.
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■ Network Name: The network name, PUBLIC1, shown in the previous dialog 
box, is an arbitrary label that mnemonically identifies the network to which a 
given network adapter is connected. Choose unique, sensible names that clearly 
identify each network that you are labeling.

■ Enable for cluster use: You can designate what type of traffic the network will 
carry. First, make sure the Enable for Cluster Use box is selected, then choose 
one of the network traffic options:

– Use for all communications allows all traffic. Click this option for clusters 
that have only a single network adapter.

– Use only for internal cluster communications allows you to use this 
adapter as a private heartbeat network. Click this option if you have 
multiple adapters and want to isolate cluster traffic to a separate network 
and set of network adapter cards.

– Use only for client access allows only client traffic. Click this option if you 
have more than one network card and do not need to use this network for 
internal cluster communications.

 Click Next to proceed. 

The installation procedure will display a dialog box for each network adapter. 

 . . . . . . . . . . 

Step 11.  Prioritize the network for private communications.
List the networks that you just configured in order of priority. Click Next to 
proceed.    
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Step 12.  Specify the virtual address for the cluster.
The MSCS Cluster Group contains a virtual server that is used by the Cluster 
Administrator to manage the cluster configuration. Define the TCP/IP parameters 
for the virtual server in the next dialog box.   

Provide the following information in the dialog box:

■ IP Address specifies the TCP/IP address for the cluster virtual server.
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Install MSCS on the First Node
■ Subnet Mask is supplied automatically by the installation procedure. The 
subnet mask is used by the cluster software to access the Cluster Group.

■ Network specifies the public interconnect that carries cluster traffic.

Click Next to proceed.

Step 13.  Complete the cluster setup dialog.
Click Finish to complete the setup dialog and begin installing the MSCS software 
on this cluster node.   

Step 14.  Reboot the cluster node.
Upon successful completion of the MSCS installation on the first node, you will be 
prompted to reboot the system. 

Click OK to reboot now.

Step 15.  Verify that the Cluster Service has started.
After the system reboots and completes authentication into the domain using the 
cluster membership account, if no service errors occur, the MSCS Cluster Service 
will start. 
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Install MSCS on the Second Node
To verify this, from the Windows taskbar, start the Services Control Panel by 
choosing:

Start -> Services

The Cluster Service status should be displayed as Started, and the Startup should be 
set to Automatic, as shown in the following Services screen: 

Click Close to exit the Services Control Panel.

E.4 Install MSCS on the Second Node
The steps for installing MSCS on the second node are very similar to the steps you 
performed on the first cluster node. Follow the steps listed in Section E.2 and 
Section E.3, but with the following changes:

■ Power on the second node.

■ Ensure that the first node is up and that the Cluster Service is started (described 
in step 15).

■ For steps 1 and 2 in Section E.3, perform the installation exactly as you did on 
the first node.

■ For step 3, choose Join an existing cluster because you are adding this cluster 
node to an existing cluster. 
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Install the Cluster Administrator on Client Systems
■ For step 4, enter the name (cluster alias) of the cluster you want to join. For 
example, to join the cluster created earlier in this chapter, you would enter the 
name NTCLU-160.

.

■ For steps 5 and 6, specify the location of the cluster executable files and the 
authentication information, as you did for the first cluster node. However, note 
that the user name and domain appear dimmed for this installation, and you 
need only supply the cluster password. This is because the Cluster Service 
authentication must be exactly the same on both nodes. Only the password is 
required input.

■ For steps 7 through 12, do nothing. These steps are applicable only to 
installations where you are creating a cluster.

■ For steps 13 through 15, do exactly as you did for the installation on the first 
node.

E.5 Install the Cluster Administrator on Client Systems
The MSCS Cluster Administrator tool can be installed on any computer running 
Microsoft Windows NT Enterprise Edition 4.0, Service Pack 3, 4, or 5.

Note: The first node in the cluster must be online and running at 
this time or the installation will fail.
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Install the Cluster Administrator on Client Systems
To install the MSCS Cluster Administrator on one or more client computers, start 
the Enterprise Edition Installer as described in Section E.2 and perform the 
installation, as described in the following steps.

Step 1.  Begin the installation.
Begin the installation exactly as you did for the server nodes (as described in steps 1 
and 2 in Section E.3).

Step 2.  Install the MSCS Cluster Administrator.
Choose Install Cluster Administrator only in the following dialog box. 

Step 3.  Specify the target location of the cluster files.
The MSCS executable files (not the quorum files) are installed, by default, into a 
new subdirectory within the Windows NT %SystemRoot% directory. Accept the 
default location or enter an alternative target location for the cluster files. The target 
location that you specify must be on a local disk, not a cluster disk.

Click Next to proceed. 
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Install the Cluster Administrator on Client Systems
Step 4.  Complete the setup dialog.
Click Finish to complete the setup dialog and begin installing the MSCS Cluster 
Administrator on this client machine.   

Step 5.  Complete the installation.
An alert dialog box displays when the MSCS Cluster Administrator installation has 
completed. Click OK to end the installation. 
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After Installation: Verify the Cluster Service
(If the Enterprise Edition Installer remains running, click Yes in the subsequent 
confirmation dialog box.)

E.6 After Installation: Verify the Cluster Service
Before installing Oracle Fail Safe, verify that the MSCS cluster is working properly 
by attempting to fail over the Cluster Group.

E.6.1 Start the Cluster Administrator
Start the Cluster Administrator from the Windows taskbar by choosing:

Start -> Programs -> Administrative Tools -> Cluster Administrator

The first time you start the Cluster Administrator, specify the name of the cluster to 
which you want to connect. Enter a valid cluster alias name and click Open to 
explore the cluster configuration. 

If the cluster is running, the main window of the Cluster Administrator should be 
similar to one shown in the following screen.
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After Installation: Verify the Cluster Service
To see different perspectives of the cluster status, open multiple copies of the child 
window by selecting Window -> New Window, and then tile the windows 
horizontally. For example, to show the status of discrete cluster resources within a 
particular group while also viewing the general status of all groups, use two child 
windows. 

In the following screen, notice that all cluster resources are currently running on the 
cluster node, NTCLU-92.

E.6.2 Fail Over the Cluster Group
Until now, MSCS has managed relatively static operations because the node boot 
sequence and timing has been carefully controlled. To verify that the cluster is 
working properly, initiate manual failover operations on various cluster groups.
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After Installation: Verify the Cluster Service
From a client window in the Cluster Administrator:

1. Select the Cluster Group in the Groups folder. 

2. Move the group by choosing:

File -> Move Group

In the example screens, this operation will move the group from NTCLU-92 (the 
node currently hosting the group) to the other cluster node (NTCLU-91). 

The following Cluster Administrator screen shows that the cluster resources have 
moved successfully and are online on the node NTCLU-91.

Follow the same procedure to fail over (fail back) the Cluster Group to the 
originating node, NTCLU-92, and verify that the failover works bidirectionally.
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